THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

© Cisco Systems, Inc. All rights reserved.
CONTENTS

CHAPTER 1
Overview of Cisco WebEx Meetings 1
Licensing Information 2
Setting Your Instant Meeting Preferences 2
Updating Your Account Information 2

CHAPTER 2
Signing In to WebEx Assistant 5
Signing In to WebEx Assistant 5
Signing In to WebEx Assistant Using Single Sign-On 6
Signing In to WebEx Assistant Using LDAP 7
Switching Sites 8
Starting an Instant Meeting with WebEx Assistant 8
Scheduling a Meeting with WebEx Assistant 9
Scheduling a Personal Conference Meeting with WebEx Assistant 10
Installing WebEx Productivity Tools 11
Setting Up WebEx Productivity Tools 12
Uninstalling WebEx Productivity Tools 12

CHAPTER 3
Selecting Audio and Meet Now Options 15
About Using WebEx Audio 15
Connecting to an Audio Conference 16
Using Your Phone to Connect to Audio 17
Leaving an Audio Conference 18
Using Your Computer to Connect to Audio 18
Fine-Tuning Your Microphone and Speaker Settings 19
Switching Audio Devices During a Meeting 19
Muting and Unmuting Microphones 20
Editing or Updating Your Stored Phone Numbers 21
Modifying the Enter and Exit Tones for Your Meeting 21
CHAPTER 11

Frequently Asked Questions  83

Application and Document Sharing  83
Hosting, Joining, and Setting up Meetings  84
Joining a WebEx Meeting or Playing Back a Meeting Recording on Chrome and Firefox  86
Cisco WebEx for Mobile Devices  86
Cisco WebEx for Mobile Devices  91
Downloading Cisco WebEx Applications  92
How Do I Enable Java?  94
How Do I Enable JavaScript?  97
Windows OS: End-User System Requirements  98
Mac OS: End-User System Requirements  101
Optimizing Performance  102

CHAPTER 12

Troubleshooting  103

Participants List Displays Multiple Entries for the Same User  104
Internet Explorer Browser Not Supported  104
404 Page Not Found Error Encountered  104
Cannot Start or Join Meeting  105
SSO Does Not Work with iOS Devices  106
Meeting Details Page Displays Incorrect Information  107
Meeting Client Does Not Load  107
Adobe Reader Launches Automatically  108
Incorrect Version of Productivity Tools Displayed in the Control Panel  109
Error Message: Setup was Unsuccessful  109
Error Message: Host Access Code and Host PIN Combination is Incorrect  110
Error Message: Participant Access Code is Incorrect  110
Error Message: We've Hit a Glitch Processing Your Request  110
Error Message When Regenerating Access Codes  111
Error When Deleting a Personal Conference Account  111
Invitees Do Not Receive Reminder Email Messages  111
Cannot Join a Personal Conference Meeting  111
Cannot Install WebEx Productivity Tools  111
"Remember Me" Function Does Not Work  112
Cannot Record Meeting  112
Contents

Cannot Play a Meeting Recording 112
Experiencing Audio or Video Issues During Meetings 113
Deleting Meetings Scheduled By a Deactivated User 114
Web Presentation Pauses 114
Cannot Access Help 114
Display Issues When Sharing on Windows 8 or 10 114
Display Issues When Sharing Using Dual Monitors 115
Overview of Cisco WebEx Meetings

Cisco WebEx Meetings provides you with tools that help you collaborate with your contacts and colleagues efficiently. Here are highlights of what you can do:

• Select **Meet Now** to start an instant meeting.
• Select **Schedule** to schedule a meeting.
• Join a meeting from your invitation email message or from the Meetings page on your WebEx site.
• Select **Recordings** to find a meeting recording.
• Use the WebEx Productivity Tools, which lets you schedule, start, and join meetings from Microsoft Outlook and WebEx Assistant, without the need to use your WebEx site.

If you haven't downloaded the Productivity Tools when activating your account, you can select **Downloads** on the top-right portion of your WebEx site and then download it from the page.

To ensure the best possible meetings experience, download the latest releases of Java software for your favorite web browser. For further assistance, contact your administrator.

• When you are away from your computer, you can schedule, start, and join meetings on your iPhone or iPad. For more information, see the Apple iPhone and iPad section in the FAQs.
• When you are away from your computer, you can schedule, start, and join meetings on your Apple or Android mobile device. For more information, see the **Cisco WebEx for Mobile Devices** section in the FAQs at [http://www.cisco.com/en/US/partner/products/ps12732/products_user_guide_list.html](http://www.cisco.com/en/US/partner/products/ps12732/products_user_guide_list.html).
• When you are away from your computer, you can schedule, start, and join meetings on your Apple or Android mobile device. For more information, see the **Frequently Asked Questions** section.
• Join PCN and Blast Dial meetings at the touch of a button using your Apple or Android mobile device. Optionally, you can join a web conference.

---

**Note**

Make sure that you enable cookies in your browser. You cannot sign in to your WebEx site if cookies in your browser are disabled.

---

- **Licensing Information, page 2**
- **Setting Your Instant Meeting Preferences, page 2**
Licensing Information

- Third-Party License and Notices (including free and open-source software)
- End-User License Agreement
- Supplemental End-User License Agreement

Setting Your Instant Meeting Preferences

An instant meeting is a meeting that you can start right away without scheduling in advance. Complete this task to set your default instant meeting preferences.

Procedure

Step 1 Sign in to your WebEx site.
The Meetings page appears.

Note If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2 Select My Account in the top right corner.

Step 3 Navigate to the Meet Now Settings section.

Step 4 Enter the requested information.

Note If you enter a password the system will require users to enter this password whenever they join your instant meeting.

Step 5 Select Update.

Related Topics

Overview of Cisco WebEx Meetings, on page 1

Updating Your Account Information

Procedure

Step 1 Sign in to your WebEx site.
The Meetings page appears.

Note If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2 Select My Account in the top right.
The **My Account** page appears.

**Step 3** Enter the requested information keeping the following notes in mind:

- Fields with an asterisk (*) are required.
- You cannot change your first name or last name if your system is configured for LDAP authentication.
- You cannot change the email address if your system is configured for single sign-on (SSO), LDAP authentication, or manual profiles.
- You cannot change the password if your system is configured for SSO.
- You cannot change the full name or email address if your system is configured for single sign-on (SSO), LDAP authentication, or manual profiles.
- **Meet Now** settings determine your default settings when you start an instant meeting.
- Contact your administrator if you need details about your system configuration.

**Step 4** Select **Update** when finished.

*Note* Make sure that you select **Update** before clicking off the **My Account** page. Otherwise, any updates you made will be lost.

**Related Topics**

- Overview of Cisco WebEx Meetings, on page 1
- Modifying the Enter and Exit Tones for Your Meeting, on page 21
Signing In to WebEx Assistant

Use WebEx Assistant to quickly start or schedule meetings, and set up or change your WebEx account settings without going to your Cisco WebEx site.

- Signing In to WebEx Assistant, page 5
- Signing In to WebEx Assistant Using Single Sign-On, page 6
- Signing In to WebEx Assistant Using LDAP, page 7
- Switching Sites, page 8
- Starting an Instant Meeting with WebEx Assistant, page 8
- Scheduling a Meeting with WebEx Assistant, page 9
- Scheduling a Personal Conference Meeting with WebEx Assistant, page 10
- Installing WebEx Productivity Tools, page 11
- Setting Up WebEx Productivity Tools, page 12
- Uninstalling WebEx Productivity Tools, page 12

Before You Begin

Make sure that WebEx Productivity Tools is installed. Your administrator might have "pushed" this application to you. If not, you can download it from the Downloads page on your WebEx site.

The Productivity Tools download page also displays instructions for signing in to Productivity Tools. Make note of the URL because you will need it for signing in to WebEx Assistant.

Procedure

Step 1 From the Start menu, select Programs > WebEx > Productivity Tools > WebEx Assistant.
The WebEx Assistant dialog box displays. If you previously signed in to WebEx Assistant, the WebEx site URL you were using is displayed in the **Current site is** field at the top of the dialog box.

**Step 2** (Optional) If you used the Mozilla FireFox or Google Chrome browsers to access your Cisco WebEx site and download Productivity Tools, do one of the following:

- Enter your on-premises Cisco WebEx Meetings Server site URL and select **Next**.
- Select **Sign in to WebEx in the cloud** to sign in to a Cisco WebEx site in the cloud, such as a Cisco WebEx Meetings or a WebEx centers site.

**Step 3** (Optional) Select the **Pencil** icon next to the Current site field to switch to a different WebEx site. To enter a new WebEx site URL, do one of the following:

- Enter an on-premises Cisco WebEx Meetings Server site URL and select **Next**.
- Select **Sign in to WebEx in the cloud** to sign in to a Cisco WebEx site in the cloud, such as a Cisco WebEx Meetings or a WebEx centers site.

**Step 4** Enter the email address and password for your WebEx account.

- For LDAP Cisco WebEx sites, enter your company email address and password.
- For Single Sign-On (SSO) Cisco WebEx sites, your company sign-in dialog displays for you to enter your username and password.

**Step 5** (Optional) Select **Remember me** if you want the system to remember your sign-in credentials. Select **Automatically sign in** if you want to remain signed in to WebEx Assistant.

**Step 6** Select **Sign In**.

**Step 7** To determine which WebEx site you are signed in to:

a) Right-click the WebEx Assistant icon on the taskbar and select **WebEx Settings**.

b) Select the Account tab.

The Account Information section displays the WebEx site you are signed in to. Some Cisco WebEx sites let you change your password or switch to a different Cisco WebEx site from the Account tab. If you make changes, select **Refresh** to update the displayed information.

**Step 8** To sign out of WebEx Assistant, right-click the WebEx Assistant icon on the taskbar and select **Sign Out**.

---

**Signing In to WebEx Assistant Using Single Sign-On**

Typically you sign in to your WebEx site using your email address and password. However, if your administrator requires that you use single sign-on—that is, sign in through your corporate website, you use a different sign-in process, provided by your company.

**Before You Begin**

Make sure that WebEx Productivity Tools are installed. Your administrator may have "pushed" this application out to you. If not, you can download it from the Downloads page on your WebEx site.
The Productivity Tools download page also displays instructions for signing in to the Productivity Tools. Take a note of the URL because you will need it for signing in to WebEx Assistant.

**Procedure**

**Step 1**
Do one of the following:

- Select **Sign in using single sign-on**.
  If you don't see the option, enter the email address associated with your WebEx account. Once the system verifies that you can use single sign-on, the option appears.

- Select **Sign in using corporate website**.

**Step 2**
Enter the URL for your WebEx site.
You are redirected to your corporate website.

**Step 3**
Enter the required information to sign in on the page.

---

**Signing In to WebEx Assistant Using LDAP**

When LDAP is enabled for your Cisco WebEx Meetings Server site, you enter your company email address and password to sign in to WebEx Assistant.

**Procedure**

**Step 1**
From the Start menu, select **Programs > WebEx > Productivity Tools > WebEx Assistant**.
The WebEx Assistant dialog box displays. If you previously signed in to WebEx Assistant, the WebEx site URL you were using is displayed in the **Current site is** field at the top of the dialog box.

**Step 2** (Optional) If you used the Mozilla FireFox or Google Chrome browsers to access your Cisco WebEx site and download Productivity Tools, do one of the following:

- Enter your on-premises Cisco WebEx Meetings Server site URL and select **Next**.
- Select **Sign in to WebEx in the cloud** to sign in to a Cisco WebEx site in the cloud, such as a Cisco WebEx Meetings or a WebEx centers site.

**Step 3** (Optional) Select the **Pencil** icon next to the Current site field to switch to a different WebEx site. To enter a new WebEx site URL, do one of the following:

- Enter an on-premises Cisco WebEx Meetings Server site URL and select **Next**.
- Select **Sign in to WebEx in the cloud** to sign in to a Cisco WebEx site in the cloud, such as a Cisco WebEx Meetings or a WebEx centers site.

**Step 4**
Enter your company email address and password.

**Step 5**
Select **Sign In**.

**Step 6**
To determine which WebEx site you are signed in to:
Switching Sites

This task describes how to switch between multiple Cisco WebEx sites.

Before You Begin

- To use the Switch Site feature, make sure you have an account on at least one Cisco WebEx Meetings Server site and one Cisco WebEx site in the cloud, or multiple accounts on Cisco WebEx sites in the cloud. Note that your WebEx accounts must be local accounts.
- The email address and password assigned for a Cisco WebEx Meetings Server site must match at least one Cisco WebEx site in the cloud.
- Switch Site is only available if your administrator has enabled the Cloud feature to allow users to sign in the Cisco WebEx in the cloud accounts from WebEx Productivity Tools.

Procedure

Step 1 Sign in to WebEx Assistant using a multi-site account. The WebEx Assistant dialog box displays.

Step 2 Right-click the WebEx Assistant icon in the taskbar and select Switch Site... The available sites display on the WebEx Assistant dialog box. The Cisco WebEx site you are currently using is listed as Signed in.

Step 3 Select Sign in next to the site you want to use. Depending on the selected site, you may be required to temporarily close Microsoft Outlook to complete the switch.

Note If required, enter a password, and then select Sign in.

Starting an Instant Meeting with WebEx Assistant

Tip Once you are signed in to WebEx Assistant, you can start an instant meeting by selecting Meet Now from the WebEx Assistant icon on the taskbar or the WebEx toolbar in Microsoft Outlook.
Before You Begin

- Make sure WebEx Productivity Tools is installed on your desktop. Your administrator may have "pushed" the WebEx Productivity Tools to your desktop.
- Sign in to WebEx Assistant.
- On the Meetings tab of the WebEx Settings dialog box, you can select the Let me change the meeting topic and password when the meeting starts check box if you want to override the topic (What) or password Meet Now settings for each instant meeting.

Procedure

Step 1
Right-click the WebEx Assistant icon on the taskbar and select Meet Now.
Depending on your WebEx Settings, a dialog box requesting meeting-specific information or the Quick Start page appears.

Step 2
(Optional) If you checked the Let me change the meeting topic and password when the meeting starts check box on the WebEx Setting dialog box, enter a topic in the What field and a one-time meeting password for this instant meeting. Then select Meet Now.
The Quick Start page appears.

Step 3
There are two ways to invite people to join your meeting:
- The Meet Now function sends an email invitation for you to forward to invitees.
- Select Invite & Remind on the Quick Start page. On the Email tab, enter the email addresses for invitees, and then select Send.

Scheduling a Meeting with WebEx Assistant

Before You Begin

- Make sure WebEx Productivity Tools is installed on your desktop. Your administrator may have "pushed" the WebEx Productivity Tools to your desktop.
- Sign in to WebEx Assistant.

Procedure

Step 1
Right-click the WebEx Assistant icon on the taskbar and select Schedule a Meeting.
A Microsoft Outlook appointment form opens. If you haven't installed Outlook, WebEx will open the schedule meeting page.

Step 2
Enter your meeting details, such as the meeting subject, start and end times, and invitees.

Step 3
Select Add WebEx Meeting from the WebEx toolbar.
The WebEx Settings dialog box appears.

**Step 4** (Optional) If you want to include a meeting password, enter it in the Meeting Information section.

**Step 5** If you want to grant other users the permission to start your meeting on your behalf, select the Alternate Host tab and select them from the list.

**Note** If your organization relies on single sign-on (SSO) and your administrator changes the email address of your alternate host, you may get a message that the email address is not found. Until the new email address is propagated during the daily synchronization between Exchange, Outlook, and CWMS, you will not be able to designate an attendee with a modified email address as an alternate host or to schedule a meeting as a delegate.

**Step 6** Select **OK** to close the WebEx Settings dialog box.
WebEx information displays in your Microsoft Outlook appointment form.

**Step 7** Select **Send** to save your meeting information and send updates to invitees.

---

**Scheduling a Personal Conference Meeting with WebEx Assistant**

**Before You Begin**

- Make sure WebEx Productivity Tools is installed on your desktop. Your administrator may have "pushed" the WebEx Productivity Tools to your desktop.
- Sign in to WebEx Assistant.
- You cannot assign an Alternate Host for a Personal Conference meeting.

**Procedure**

**Step 1** Right-click the WebEx Assistant icon on the taskbar and select **Schedule a Meeting**.
A Microsoft Outlook appointment form opens. If you haven't installed Microsoft Outlook, WebEx will open the schedule meeting page.

**Step 2** Enter your meeting details, such as the meeting subject, start and end times, and invitees.

**Step 3** Select **Add WebEx Meeting** from the WebEx toolbar.
The WebEx Settings dialog box appears.

**Step 4** On the Audio Conference tab, select either WebEx Audio or a Personal Conference account.

**Step 5** (Optional) If you select Personal Conferencing as your Audio Connection before you create a host PIN and Personal Conference account, the system asks you to do the following:

a) Select **View Audio Options** on the Personal Conference Account Required message box. If you select **Cancel**, the Audio Connection setting returns to WebEx Audio and you can continue to schedule a WebEx Audio meeting.

b) On the My Account page, go to the My Audio Connection Options section.
c) Select **Personal Conferencing**.
d) Enter a 4-digit host PIN.
e) Select Save PIN and Generate Account.
f) On the WebEx Settings dialog box, select Cancel to close the dialog box.
g) Close the Microsoft Outlook appointment form.
h) Return to Step 1 to schedule the Personal Conference meeting again.

Step 6
Select OK to close the WebEx Settings dialog box.

Step 7
Select Send to save your meeting information and send meeting invitations to invitees.
The scheduled meeting displays in your Outlook calendar and the list of meetings on your Cisco WebEx site.

Installing WebEx Productivity Tools

Before installing WebEx Productivity Tools, ensure that your computer meets the following minimum system requirements:

- Intel Core2 Duo CPU 2.XXX GHz or AMD processor (2GB of RAM recommended)
- JavaScript and cookies enabled in the browser
- Supported operating systems and browsers

Note
For the latest end-user system requirements, including supported operating systems and browsers, see the Cisco WebEx Meetings Server System Requirements at http://www.cisco.com/c/en/us/support/conferencing/webex-meetings-server/products-installation-guides-list.html.

For the latest end-user system requirements, including supported operating systems and browsers, see the Cisco WebEx Meetings Server Planning Guide and System Requirements.

Procedure

Step 1
Sign in to your WebEx site.
The Meetings page appears.

Note  If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2
In the top navigation, select Downloads.

Note  The Downloads option is only available if your administrator has enabled it.

Step 3
Under Productivity Tools, select Download.
The File Download dialog box appears.

Step 4  (Optional) Save the installation program (with the extension .msi) to your computer.

Step 5
Run the installation file and follow the instructions.
After the installation completes, sign in to your WebEx account when prompted, and check your settings in the WebEx Settings dialog box.

**Step 6** (Optional) If the download does not start automatically, select the **click here to download** link. Run the installation file and follow the instructions.

---

**Setting Up WebEx Productivity Tools**

**Procedure**

**Step 1** Open the WebEx Settings dialog box.

**Step 2** Select the **Account** tab.

From this tab, you can do the following:

- Select **Change password** to update your WebEx password.
- Select **Update Regional Preferences** to update your time zone, language, or locale on the My Account page. Select **Update** to save your changes, and then return to the WebEx Settings dialog box.

**Note** The **Time Zone** setting determines the time of a WebEx meeting after the meeting is successfully scheduled. The **Locale** setting determines the format for the time, date, currency and phone numbers displayed on the Meetings page, and the email invitations and notification messages.

- Select **Update Regional Preferences** to update your time zone, language, or locale.

**Note** The **Time Zone** setting is used to determine the time for a scheduled WebEx meeting, and **Locale** localizes meeting details such as the format of the date and phone numbers.

- Select **Refresh** to see the most recent changes to your WebEx site.

**Step 3** Select **Apply** to apply any changes.

**Step 4** Select the **Meetings** tab.

**Step 5** Select **Set meeting preferences** to define your default settings for meetings you start instantly from Microsoft Outlook.

**Step 6** Select **Update** to save your changes, and then return to the WebEx Settings dialog box.

**Step 7** (Optional) If you want the option to change your meeting topic and password before your instant meeting starts, check the provided option.

**Step 8** Select **OK** to close the WebEx Settings dialog box.

---

**Uninstalling WebEx Productivity Tools**

This task describes how to uninstall WebEx Productivity Tools from the Windows Start menu. You can uninstall Productivity Tools at any time. Uninstalling Productivity Tools removes all Productivity Tools and shortcuts from your computer.
You can also uninstall Productivity Tools from the Windows Add/Remove Programs option.

Procedure

**Step 1**  Click **Start > Programs > WebEx > Productivity Tools > Uninstall.**

**Step 2**  Click **Yes** to confirm that you want to uninstall WebEx Productivity Tools.
Selecting Audio and Meet Now Options

Before you schedule or start your first meeting, go to My Account and configure your audio options. The My Audio Connection Options and Meet Now Settings appear as the default options when you schedule all your meetings. You can change the type of audio connection and meet now settings when you schedule your meeting.

- About Using WebEx Audio, page 15
- Connecting to an Audio Conference, page 16
- Using Your Phone to Connect to Audio, page 17
- Leaving an Audio Conference, page 18
- Using Your Computer to Connect to Audio, page 18
- Fine-Tuning Your Microphone and Speaker Settings, page 19
- Switching Audio Devices During a Meeting, page 19
- Muting and Unmuting Microphones, page 20
- Editing or Updating Your Stored Phone Numbers, page 21
- Modifying the Enter and Exit Tones for Your Meeting, page 21
- About Using Personal Conferencing, page 22
- Creating Your Personal Conference Account, page 24
- Dialing In to a Personal Conference Meeting, page 25
- Regenerating Access Codes, page 26
- Deleting a Personal Conference Account, page 27

About Using WebEx Audio

WebEx Audio lets you use either your phone or your computer to hear others and to speak in your meeting:

- **Phone**—you can use your phone to receive a call to the audio portion of the meeting or to dial in.
• **Computer**—you can use a headset connected to your computer to join the audio portion of the meeting if the computer has a supported sound card and a connection to the Internet.

**Note**

If you are a host, the number of people to participate in the audio conference depends on the size of your system.

After joining the conference, participants can switch between audio modes with little or no listening interruption. In a mixed-mode conference, where some participants are using the telephone and others are using the computer, all participants can speak.

Your role in an audio conference determines your level of participation. Whichever role you take, the following table describes the basic tasks you can accomplish in that role.

<table>
<thead>
<tr>
<th>Role in Audio Conference</th>
<th>Task Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host an audio conference</td>
<td>• Join or leave the audio conference</td>
</tr>
<tr>
<td></td>
<td>• Switch audio connection modes</td>
</tr>
<tr>
<td></td>
<td>• Mute or unmute one or more microphones</td>
</tr>
<tr>
<td></td>
<td>• Use caller authentication to join the conference</td>
</tr>
<tr>
<td></td>
<td>• Edit or update phone numbers in your user profile</td>
</tr>
<tr>
<td>Participate in an audio conference</td>
<td>• Join or leave the audio conference</td>
</tr>
<tr>
<td></td>
<td>• Switch audio connection modes</td>
</tr>
<tr>
<td></td>
<td>• Ask to speak</td>
</tr>
<tr>
<td></td>
<td>• Mute or unmute your microphone</td>
</tr>
<tr>
<td></td>
<td>• Use caller authentication to join the conference</td>
</tr>
<tr>
<td></td>
<td>• Edit or update phone numbers in your user profile</td>
</tr>
</tbody>
</table>

**Related Topics**

- About Using Personal Conferencing, on page 22
- Setting Your Instant Meeting Preferences, on page 2
- Allowing Another User to Schedule Meetings for You, on page 40

**Connecting to an Audio Conference**

Once you start or join a meeting that uses WebEx Audio, the **Audio Conference** dialog box appears automatically on your screen.
What device do you want to use for speaking and listening in the meeting?

- **Your phone**: Typically provides good voice transmission, but may have a cost attached.
- **Your computer** (with a headset, and an Internet connection): Sometimes causes noisy transmission, or an irregular voice stream, but has no cost attached.

You can select your preferred device from the **Audio Conference** dialog box.

## Using Your Phone to Connect to Audio

After you join a meeting, the **Audio Connection** dialog box appears automatically. When you use your phone to connect to the audio portion of the meeting, you can call in or receive a call back.

- **Call in**—call in from your phone to a number your host provides.
- **Call back**—receive a call at a valid number you provide, or at a number that is already stored in your user profile. A valid number can be an internal number or an external number that contains an area code and seven-digit local phone number.

**Note**

If you join a meeting that is already in progress and shared content is all you see, select **Audio** on the Meeting Controls panel at the top of your screen to access the **Audio Connection** dialog box.

### Procedure

**Step 1**

To receive a call back, do one of the following in the **Audio Connection** dialog box:

- Click **Call Me** to receive a call at the number displayed.
- Select another number from the drop-down list of available numbers, then click **Call Me**.
- Select **Call me at a different number** from the drop-down list, click on the country flag and select the country, enter a phone number, then click **Call me**.
- Select **Call me at an internal number** from the drop-down list, enter a number, then click **Call Me**.

**Step 2**

To call in, select **I will call in** from the drop-down menu in the **Audio Connection** dialog box.

**Step 3**

Follow the instructions to join the audio conference.

A phone icon appears next to your name in the Participants list to indicate that you are using your phone in the audio conference.

### Related Topics

- [Switching Audio Devices During a Meeting](#), on page 19
- [Switching Audio Devices During a Meeting](#), on page 19
Leaving an Audio Conference

Procedure

**Step 1** Open the Audio Conference dialog box from one of the following:

- The Quick Start page
- Your Participant list
- The Audio menu
- The Meeting Controls panel (if you are sharing)

**Step 2** Select **Disconnect Audio**.
Your participation in the audio conference ends; however, your participation in the meeting continues until you leave it or the host concludes it.

Using Your Computer to Connect to Audio

After you join a meeting, the **Audio Connection** dialog box appears automatically. When you use your computer to speak and listen in a meeting, your computer sends and receives sound across the Internet. To do this, your computer must have a supported sound card and be connected to the Internet.

**Note**
If you join a meeting that is already in progress and shared content is all you see, select **Audio** on the Meeting Controls panel at the top of your screen to access the **Audio Connection** dialog box.

**Before You Begin**
Make sure that you use a computer headset with a high-quality microphone rather than speakers and a microphone for the best audio quality and convenience.

Procedure

**Step 1** Select **More Options** to view more audio connection options.

**Step 2** Select **Call Using Computer**.

**Note** If this is your first time connecting to a meeting with your computer, the **Speaker/Microphone Audio Test** window appears so that you can fine tune your sound settings.

A headset icon appears next to your name in the Participants list to indicate that you are using your computer in the audio conference. Now that you are connected to your meeting, you can do the following:

- Mute or unmute your speaker or microphone
• Change the volume on your speaker or microphone

Related Topics
Fine-Tuning Your Microphone and Speaker Settings, on page 19
Country Code Values

Fine-Tuning Your Microphone and Speaker Settings
If you are using your computer to connect to the meeting audio, you can fine-tune your microphone and speaker settings to optimize your audio experience.

The Speaker/Microphone Audio Test walks you through testing your devices, and setting your speaker volume and microphone level.

When you first start or join a meeting, you can manually test and adjust your sound device before you actually start using your computer for audio.

Tip
After you join the audio portion of the meeting you can retest your settings at any time simply by reopening the Audio Connection dialog box, selecting Change settings > Test speaker/microphone.

Procedure

Step 1
From the meeting window, select Audio > Computer Audio Settings > Speaker/Microphone Audio Test.

Step 2
Follow the instructions.

Switching Audio Devices During a Meeting
You can easily switch from one audio device to another during a meeting with little disruption.

Procedure

Step 1
To switch from your computer connection to a phone connection:
a) Open the Audio Connection dialog box from one of the following:
   • The Quick Start page
   • Your Participant list
   • The Audio menu
   • The Meeting Controls panel (if you are sharing)
b) Select **More Options** to view more audio connection options.

c) Select **I Will Call In** and call the number in the call area, enter the access code and attendee ID, as directed by the automated operator. Alternatively, select **Call Me** and select or enter the phone number. After you are connected by phone, your computer connection is dropped automatically.

**Step 2** To switch from your phone connection to a computer connection:

a) Open the **Audio Connection** dialog box from one of the following:

- The **Quick Start** page
- Your **Participant** list
- The **Audio** menu
- The **Meeting Controls** panel (if you are sharing)

b) Select **More Options** to view more audio connection options.

c) Select **Call Using Computer**.

Your phone connection is dropped after your computer connection is established.

**Tip** Remember to switch to your computer headset.

---

**Muting and Unmuting Microphones**

The following table illustrates how to quickly mute and unmute microphones in your meeting depending on your user role.

Windows users: Right-click in the Participants list, then select one of the described options.

Mac users: Ctrl + click in the Participants list, then select one of the described options.

**Note** During sharing, you can mute and unmute your microphone from the **Meeting Controls** panel at the top of your screen.

<table>
<thead>
<tr>
<th>Role</th>
<th>Options</th>
</tr>
</thead>
</table>
| Host   | • **Mute on Entry** to mute all microphones automatically when participants join a meeting  
|        | • **Mute or Unmute** to mute or unmute your own or a specific participant's microphone  
|        | • **Mute All** to mute or unmute all participant microphones simultaneously at any time during a meeting |
The microphone icon to the right of the participant's name changes state.

### Editing or Updating Your Stored Phone Numbers

You can edit or update the phone numbers listed in your profile in the following circumstances:

- You have not yet joined the audio conference or
- You joined the audio conference from your computer

In addition, you can view any phone number that is stored as a cookie on your computer. Any updates you make do not take effect until the next time you join a meeting.

**Before You Begin**

Make sure that you are not participating in an audio conference by phone if you want to edit or update your phone numbers.

**Procedure**

1. **Step 1**
   Do either of the following:
   - From the meeting window, select **Audio > Audio Connection**.
   - Select **More Options** under **Connect to audio**.
   
   The Audio Connection dialog box appears.

2. **Step 2**
   Select **call me at a different number**.

3. **Step 3**
   Select **Manage phone numbers** from the drop-down box.
   
   The Manage phone numbers dialog box appears.

4. **Step 4**
   Select **Edit** to update the phone numbers in your WebEx profile, or **Clear** to delete phone numbers that are stored as cookies on your computer.

**Modifying the Enter and Exit Tones for Your Meeting**

This task describes how to modify what you hear when participants enter or exit your audio meeting.
Procedure

Step 1  Sign in to your WebEx site.
        The Meetings page appears.

       Note  If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2  Select My Account in the top right.
        The My Account page appears.

Step 3  Scroll down to the My Audio Connection Options section.

Step 4  Choose what indicator you want to hear when someone enters or exits the audio conference.

Step 5  Select Update.

       Note  Make sure that you select Update before clicking off the My Account page. Otherwise, any updates you made will be lost.

Related Topics

Updating Your Account Information, on page 2

About Using Personal Conferencing

Personal Conferencing audio connection mode lets a meeting host quickly start the audio portion of a Cisco WebEx meeting at any time. The meeting host and participants simply dial the same call-in number, enter access codes, and the audio portion of the meeting begins. The system then sends an email to the meeting host with a link to the online portion of the meeting. If the host chooses to start the online meeting, participants can then use it to share information or collaborate on an idea. The meeting host is not required to schedule Personal Conference meetings in advance, and once generated, the access codes do not change.

Personal Conference meetings are only available if your site supports Personal Conferencing. Before you can have a Personal Conference meeting, you need to create a Personal Conference account and host PIN. You can dial in to a Personal Conference meeting using either your phone or your computer.

• Phone

  • Use the call-in numbers provided on the My Accounts page or in the email meeting invitation to dial in to a Personal Conference meeting. To view the call-in numbers on the My Accounts page, go to the My Audio Connection Options section and select Personal Conferencing. If the host has scheduled the meeting, the call-in numbers are included in the email invitation sent to all invitees. The meeting host is not required to schedule a Personal Conference meeting if all participants plan to dial in to a meeting using a telephone.

  • Receive a call at a valid number you provide or at a number that is already stored in your user profile using Call Me. If you use this option, once you start the web portion of the meeting you cannot control the meeting from your keypad.

• Computer - meeting participants can use a computer with a headset connected, if the computer has a supported sound card and a connection to the Internet, to join the audio portion of a Personal Conference meeting. When one or more meeting participants plan to dial in to a meeting using a computer, the meeting host should schedule the meeting. First, meeting participants will start and join the online portion
of the scheduled Personal Conference meeting by selecting the meeting link found in the email invitation. Once connected to the meeting, the host and participants use the information available on the Audio Conference dialog box to connect to the audio portion of the meeting.

After joining the meeting, participants can switch between audio modes with little or no listening interruption. In a mixed-mode conference, where some participants are using the telephone and others are using a computer, all participants can speak.

Note

The number of people who can join a Personal Conference meeting depends on the configuration of the system. Contact your administrator for more detailed information.

Your role in an audio conference determines your level of participation. The following table lists the basic tasks a host and invitee can accomplish before and during a Personal Conference meeting.

<table>
<thead>
<tr>
<th>Role in Personal Conference Meeting</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Create a host PIN and Personal Conference account before starting or scheduling your first Personal Conference meeting</td>
</tr>
<tr>
<td></td>
<td>Schedule a Personal Conference meeting</td>
</tr>
<tr>
<td></td>
<td>Dial a call-in number and enter a host access code and host PIN to start or join a meeting</td>
</tr>
<tr>
<td></td>
<td>Use the phone keypad to do the following:</td>
</tr>
<tr>
<td></td>
<td>• *1 dial out</td>
</tr>
<tr>
<td></td>
<td>• *5 lock and unlock a meeting</td>
</tr>
<tr>
<td></td>
<td>• *6 mute or unmute self</td>
</tr>
<tr>
<td></td>
<td>• *7 send a reminder email to an invitee</td>
</tr>
<tr>
<td></td>
<td>Note: The system sends only one reminder email message to invitees, regardless of the number of times the host presses *7.</td>
</tr>
<tr>
<td></td>
<td>• *8 allow the meeting to continue without the host</td>
</tr>
<tr>
<td></td>
<td>• ## mute all participants</td>
</tr>
<tr>
<td></td>
<td>• 99 unmute all participants</td>
</tr>
<tr>
<td></td>
<td>• *# play participant count</td>
</tr>
<tr>
<td></td>
<td>• ** DTMF help</td>
</tr>
<tr>
<td>Host</td>
<td>After starting the online portion of a Personal Conference meeting, a host can:</td>
</tr>
<tr>
<td></td>
<td>• Pass the host role to another meeting participant</td>
</tr>
<tr>
<td></td>
<td>• Reclaim the host role from a meeting participant</td>
</tr>
<tr>
<td></td>
<td>• Select Record in the upper right corner of the Meetings page to record the meeting</td>
</tr>
</tbody>
</table>
### Role in Personal Conference Meeting

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invitee</td>
<td>Dial a call-in number and enter a participant access code to join a meeting. Use the phone keypad to do the following:</td>
</tr>
<tr>
<td></td>
<td>• *6 mute or unmute self</td>
</tr>
<tr>
<td></td>
<td>• *# play participant count</td>
</tr>
<tr>
<td></td>
<td>• ** DTMF help</td>
</tr>
</tbody>
</table>

  After joining the online portion of a Personal Conference meeting, an invitee can:

  • Become a meeting host, if the host passes the host role to you
  • Pass the host role to another meeting participant

### Note

If your System Administrator has enabled the **Voice connection using computer** option, when the web portion of a Personal Conference meeting is started, the audio key shortcuts on all phone users' keypads are disabled.

### Related Topics

- Using Your Phone to Connect to Audio, on page 17
- Scheduling a Meeting from the WebEx Site, on page 35
- Creating Your Personal Conference Account, on page 24
- Setting Your Instant Meeting Preferences, on page 2

### Creating Your Personal Conference Account

You must create a host PIN and at least one Personal Conference account before you schedule or start a Personal Conference meeting. For each account, the software generates unique host and participant access codes. The system prompts you for these codes after you dial a call-in number to start or join a Personal Conference meeting.

**Before You Begin**

Personal Conferencing must be enabled for your site.
Procedure

Step 1
Select My Account in the top right corner of the Meetings page.

Step 2
Select Personal Conferencing in the My Audio Connection Options section.

Step 3
Enter a 4-digit host PIN and select Save PIN and Generate Account. Account 1 host and participant access codes appears below the host PIN.

Note You use the same host PIN for all accounts.

Step 4
(Optional) To create another account select the Add another account link. A new account with unique access codes displays. These access codes remain the same until you regenerate the codes or delete the account. You can create up to three accounts.

Note While a Personal Conference meeting is in progress, you cannot add a new account.

Related Topics

Scheduling a Meeting from the WebEx Site, on page 35
Dialing In to a Personal Conference Meeting, on page 25

Dialing In to a Personal Conference Meeting

The meeting host and participants dial the same call-in number and enter a host or participant access code to start a Personal Conference meeting at any time. When all participants dial in to the meeting using a phone, the host is not required to schedule the meeting.

If a meeting participant wants to dial in to a Personal Conference meeting using a computer and a headset, the host should schedule a Personal Conference meeting to allow the person dialing in with a computer to join the online portion of the meeting before connecting to the audio portion of the meeting.

Note When you dial in to a Personal Conference meeting, if you are prompted to enter your access code or meeting number, always enter your access code.

Before You Begin

- Personal Conferencing must be enabled for your site.
- A valid host PIN and at least one Personal Conference account must exist.
- The host should know if participants plan to dial in to the Personal Conference meeting using a phone or a computer with a headset.
Procedure

**Step 1** Select **My Account** in the top right corner of the Meetings page.

**Step 2** Select **Personal Conferencing** in the My Audio Connection Options section.

**Step 3** Select an **account**.  
The host PIN, and host and participant access codes display.

**Step 4** Convey the call-in number and participant access code to meeting participants.

**Step 5** The meeting host dials the call-in number. When prompted, the host enters a host access code and PIN.

**Step 6** Meeting participants dial the same call-in number. When prompted, the participants enter a participant access code.  
If participants dial in to the meeting early, they remain on hold until the host dials the call-in number and enters the host access code and PIN. Once the host is connected to the meeting, all participants on hold are automatically connected to the audio portion of the meeting. If the administrator has enabled the audio option to allow participants to join the audio portion of the meeting before the host, participants who dial in early are immediately connected to the audio portion of the meeting after entering the participant access code.

**What to Do Next**

- The host can start the online portion of the meeting to share information that meeting participants can view on their desktops. The host can start the meeting from the email invitation by selecting the meeting link, or by selecting **Start** from the Meetings page after signing in to a Cisco WebEx Meetings Server site.

- Anyone can leave the meeting by hanging up their phone or ending the call.

- A meeting host can press *8 on the phone before hanging up to allow meeting participants to continue the meeting without a host.

- If the meeting host simply hangs up the phone (without pressing *8 first) meeting participants can continue the meeting for five minutes before the meeting ends.

**Related Topics**

- Joining a Meeting From an Email, on page 30
- Using Your Computer to Connect to Audio, on page 18
- Leaving an Audio Conference, on page 18
- Joining a Meeting From the Meetings Page, on page 32

**Regenerating Access Codes**

For security purposes, you can regenerate access codes.
Invitees will have incorrect access codes for upcoming Personal Conference meetings scheduled with an account that has regenerated access codes.

**Procedure**

**Step 1** Select *My Account* in the top right corner of the Meetings page.

**Step 2** Select *Personal Conferencing* in the *My Audio Connection Options* section. Existing accounts are listed.

**Step 3** Select *Regenerate access codes.* The new access codes display for the account.

**Note** While a Personal Conference meeting is in progress, you cannot regenerate access codes.

**What to Do Next**

- Send an email with the new access codes to all invitees who have the old access codes.
- Consider rescheduling previously scheduled Personal Conference meetings after you regenerate access codes for an account. When you reschedule a meeting, invitees receive updated email invitations with valid access codes.

**Related Topics**

- [Editing a Meeting, on page 41](#)

## Deleting a Personal Conference Account

You can delete Personal Conference accounts if you no longer need them.

### Note

Invitees will have incorrect access codes for upcoming Personal Conference meetings scheduled with an account that has been deleted. Personal Conference meetings scheduled with other accounts may also be affected.

### Procedure

**Step 1** Select *My Account* in the top right corner of the Meetings page.

**Step 2** Select *Personal Conferencing* in the *My Audio Connection Options* section. Existing accounts are listed.

**Step 3** Select *Delete.* The account is removed from the list.
Note  While a Personal Conference meeting is in progress, you cannot delete an account.

What to Do Next
Consider rescheduling previously scheduled Personal Conference meetings after you delete an account. When you reschedule a meeting, invitees receive updated email invitations with valid access codes.

Related Topics
  Editing a Meeting, on page 41
Joining a Meeting

When a meeting host schedules a meeting or starts an instant meeting by using the **Meet Now** option, the host and all invitees receive an email invitation with the meetings details. When it's time to join a meeting, invitees select the meeting URL in the email invitation or in an instant message.

- Before You Join a Meeting, page 29
- Joining a Meeting From an Email, page 30
- Joining a Meeting From the Meetings Page, page 32
- Joining By Meeting Number, page 32

Before You Join a Meeting

This section describes some of the things you might experience when you join a meeting.

The size of your system determines the maximum number of people who can join a meeting. When number of meeting participants reaches the maximum size, users who try to start new meetings or join meetings see an error message and the system prevents them from starting or joining a meeting. Users who dial into the meeting hear an audio prompt indicating that he or she cannot start or join a meeting because the system has reached the maximum participant capacity.

For any meeting, only half of the maximum number of participants can use video. Video is defined as sending or receiving, meaning users are using their WebEx webcam video or the video file share option which allows them to share a video.

If your WebEx site uses self-signed certificates instead of certificates from a well-known Certificate Authority, after your data center is joined to another data center users must install a certificate for each data center in the Trusted Root Certification Authorities store before they start or join a meeting.

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select **Download** and follow the instructions to install the required plug-in.

---

1 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option and select **Done**.
- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.

If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you might be required to complete the following one-time installation to add the Cisco WebEx extension to your Chrome browser:

1. Select **Add WebEx to Chrome**.
2. Select **Free** on the Cisco WebEx Extension dialog.
3. Select **Add** to add the Cisco WebEx extension to your Chrome browser.
4. Open the Cisco_WebEx_Add-on.exe file and select **Run**.
5. The page refreshes when the installation has finished. If the meeting does not start automatically, refresh the page.

## Joining a Meeting From an Email

**Procedure**

**Step 1**
Open your email invitation, then select the link.
The meeting details page appears for the meeting you are joining.

**Note**
If you are joining a meeting that is part of a recurring series, the meeting details page may reflect the incorrect date. This is a known issue and will not impact your ability to join your current meeting from this page.

**Step 2**
If requested, enter the required information. Details you may need to enter include the following:

- **Your name**: Enter the name you want attendees to use to identify you during the meeting.
- **Email address**: Enter your email address in this format: name@your_company. For example, msmith@company.com.
- **Meeting password**: Enter the meeting password. The meeting host may have included the password in the email invitation or, for security reasons, provided it to you in another way.

**Step 3**
Select **Join**.

- If you are already signed in or do not have an account on this WebEx site, wait for the meeting client to launch.
• If you are not signed in but you do have an account on this WebEx site, the system will redirect you to a sign-in page where you can enter your user credentials before joining your meeting.

**Note** If your site is configured for single sign-on (SSO), the sign-in page will be on your company's SSO site. If your site is not configured for SSO, you will sign in through the WebEx sign in page.

---

**What to Do Next**

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select **Download** and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.*

---

**Note** After installing the plug-in, it might be necessary to enable it.

• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option and select **Done**.

• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.

---

If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you might be required to complete the following one-time installation to add the Cisco WebEx extension to your Chrome browser:

1. Select **Add WebEx to Chrome**.
2. Select **Free** on the Cisco WebEx Extension dialog.
3. Select **Add** to add the Cisco WebEx extension to your Chrome browser.
4. Open the Cisco_WebEx_Add-on.exe file and select **Run**.
5. The page refreshes when the installation has finished. If the meeting does not start automatically, refresh the page.

If you are not automatically prompted by the system, select **Audio Conference** to join the audio portion of your meeting.

---

2 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
Joining a Meeting From the Meetings Page

Procedure

**Step 1** Sign in to your WebEx site.
The Meetings page appears.

*Note* If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

**Step 2** Locate your meeting in the Today list.
If your meeting is not visible, select the All Meetings tab and enter your search parameters to locate it.

**Step 3** Select Join.

What to Do Next

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select Download and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.*

*Note*

- After installing the plug-in, it might be necessary to enable it.
  - If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the Always allow plug-ins... option and select Done.
  - If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select Allow and Remember.

If the meeting does not start automatically, refresh the page.

If you are not automatically prompted by the system, select Audio Conference to join the audio portion of your meeting.

Joining By Meeting Number

You can join a meeting by using the meeting number whether you are signed in to Cisco WebEx or not.

Procedure

Complete one of the following:

---

3 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
Joining a Meeting

Joining By Meeting Number

<table>
<thead>
<tr>
<th>If</th>
<th>Do This</th>
</tr>
</thead>
</table>
| You are already signed in to your WebEx site | 1 Make sure that you are on the Meetings page by selecting the Meetings tab.  
2 Select Join by Number.  
3 Enter the meeting number.  
4 Enter the meeting password, if requested.  
5 Select Join. |
| You are not signed in to your WebEx site | 1 Open your web browser and navigate to your WebEx site.  
2 Select the Join by Number link in the top right of the header.  
3 Enter the requested information on the Join by Number page.  
4 Select Join. |

Tip You can also access the Join by Number page by entering your public WebEx site URL followed by/orion/join, for example, https://<public site url>/orion/join

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select Download and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.

Note After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the Always allow plug-ins... option and select Done.
- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select Allow and Remember.

If the meeting does not start automatically, refresh the page.

Troubleshooting Tips
If you cannot join the meeting by using the meeting number, do the following:

- Make sure that you are entering the correct meeting number.
- Make sure that it is the correct time to join the meeting.
- If your information is correct, search for the meeting on the Meetings page and try to join from the link.
Starting or Scheduling a Meeting

- Scheduling a Meeting from the WebEx Site, page 35
- Starting a Meeting from the WebEx Site, page 37
- Starting an Instant Meeting, page 38
- Starting a Meeting From Your Instant Messenger, page 39
- Allowing Another User to Schedule Meetings for You, page 40
- Finding a Meeting, page 41
- Editing a Meeting, page 41
- Editing a Recurring Meeting, page 42
- Canceling a Meeting, page 43
- Recurrence Pattern Support, page 44

Scheduling a Meeting from the WebEx Site

Before You Begin
A host must have a license to schedule or start a WebEx meeting.

Procedure

Step 1  At the top of the Meetings page, select Schedule. The Schedule a WebEx Meeting page appears.

Note  You can schedule a meeting on behalf of another host by selecting the host from the Schedule for: drop-down list. A prompt is displayed telling you that the new host scheduling privileges are transferred for the meeting. Shared information such as meeting topic, date, length, and recurrence remain the same. You can then continue scheduling the meeting using the hosts' privileges.

Step 2  Specify the following information for your meeting:
- What: What the meeting is about?
• When: When the meeting will take place?
  To schedule a recurring meeting, select Recurrence then choose your option.

• Length: How long the meeting will be?

• Meeting Type: Which type of meeting it is?
  The meeting types available for selection by the meeting host. Set up by your administrator, the meeting type determines the various conferencing features and options available for the meeting. For example, recording may or may not be available for a given meeting type.

• Who: Who do you want to invite to your meeting? You can type email addresses or type names to search for in your contacts. You can also invite people later after you have scheduled the meeting.
  Note If you want to allow an invitee to have most of the same hosting privileges as you do, select the Alternate Host option for that invitee. An alternate host cannot edit or delete a meeting. If you join the meeting after an alternate host has started it, you automatically become the host. If your organization relies on single sign-on (SSO) and your administrator changes the email address of your alternate host, you may get a message the email address is not found. The new email address is propagated during the daily synchronization between Exchange, Outlook, and CWMS. Before that synchronization, you cannot designate an attendee with a modified email address as an alternate host or schedule a meeting as a delegate.

Step 3 Select your audio connection type.
  Note The audio options can be changed from the scheduling page only by changing the meeting type. The available options are indicated with a green checkmark. Unavailable options are indicated with a red cross. You cannot change the meeting type when using Meet Now to start a meeting.

  • WebEx Audio - This audio connection mode lets meeting hosts and participants join the online portion of the meeting using the link provided in the meeting email invitation message. Once connected to a meeting, users can either call in to the meeting or use the Call Me feature to receive a call at a number they have provided. This option requires a host to schedule a meeting with either the Meet Now feature or the scheduler.

  • Personal Conferencing - This audio connection mode lets a meeting host quickly start the audio portion of a Cisco WebEx meeting at any time. The meeting host and participants simply dial the same call-in number, enter access codes, and the audio portion of the meeting begins. The system then sends an email to the meeting host with a link to the online portion of the meeting. If the host chooses to start the online meeting, participants can then use it to share information or collaborate on an idea. The meeting host is not required to schedule Personal Conferencing meetings in advance, and once generated, the access codes do not change.
  
  Note You must have a Personal Conference account and a host PIN to use the Personal Conferencing option.

Step 4 (Optional) For a WebEx meeting, enter a Meeting Password.
  • Enter password if you want to make your meetings private. Your invitees are required to enter the meeting password to join the meeting unless they are already signed in to their WebEx account.

  • For extra security, check Exclude password from email invitation. Excluding the password means that it is not displayed in the meeting details page or any email invitations. As the meeting host, you can then choose to send the password specifically to your invitees and others who request it.

Step 5 (Optional) Select Record this meeting to have the system automatically start recording when the meeting starts.
If the host joins as a participant and then assumes the host role, the meeting does not start automatically. In this case the host must start the recording manually.

**Step 6** (Optional) Select **Require attendees to sign in with single sign-on authentication before joining this meeting** to make sure only authenticated users can join your meeting. Guests cannot join.

**Note** This check box is only available if Single Sign-On (SSO) is configured on the system, and your system administrator has enabled SSO authentication for attendees.

**Step 7** (Optional) Select **Restrict meeting to invited attendees only** to make sure only authenticated and invited users can join your meeting.

**Note** This check box is only available if Single Sign-On (SSO) is configured on the system, and your system administrator has enabled SSO authentication for attendees.

**Step 8** Select **Schedule It!**. The meeting details page appears with a message confirming that your meeting is scheduled.

**Note** The maximum meeting length is 24 hours.

**Note** The system prevents you from scheduling a meeting during a scheduled maintenance window or when a future maintenance window is scheduled.

**Related Topics**
- **Recurrence Pattern Support**, on page 44
- **Editing a Meeting**, on page 41
- **Canceling a Meeting**, on page 43

---

### Starting a Meeting from the WebEx Site

**Before You Begin**

A host must have a license to start a WebEx meeting.

**Procedure**

**Step 1** Sign in to your WebEx site. The **Meetings** page appears.

**Note** If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

**Step 2** Locate the meeting that you want to start.

**Tip** The Start button only displays as green if you are within the acceptable time to start the meeting.

**Step 3** Select **Start**.

**Step 4** (Optional) If the meeting you are starting is part of a recurring series, confirm that you want to start the next upcoming meeting in the series. The meeting is started.
Starting an Instant Meeting

Before You Begin
A host must have a license to start an instant WebEx meeting.

Procedure

Step 1 From the top of your Meetings page, select Meet Now.
Step 2 Enter your meeting details, including the names or email addresses of people you want to invite to your meeting.
Step 3 (Optional) If you see the Meeting Password field, do the following:
  • Check Show actual password if you want to see the password that you are entering.

---

5 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
• For additional security, check **Exclude password from email invitation**. Excluding the password means that it will not appear in the meeting details page or any email invitations. As the meeting host, you can then choose to send the password specifically to your invitees and others who request it.

**Tip** If you don't see the password field, it's possible that you didn't set a meeting password in your account settings or your administrator didn't configure your WebEx system to require one. If you want the option of setting a password for your instant meetings, select **My Account** and enter one in the Meet Now Settings section. You can always change the password when you set up your meeting.

**Step 4** Select **Start**.

---

**What to Do Next**

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select **Download** and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.*

---

**Note** After installing the plug-in, it might be necessary to enable it.

• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option and select **Done**.

• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.

---

**Starting a Meeting From Your Instant Messenger**

After you install WebEx Productivity Tools, a WebEx tab displays whenever you start a chat from your supported instant messenger client. Select the relevant option to start a meeting or invite people to your WebEx meeting.

**Before You Begin**

This release of Cisco WebEx Productivity Tools integrates with the following instant messenger clients:

• Lync 2010 (32-bit)
• Lync 2013 (32-bit)
• Microsoft Office Communicator 2007
• Microsoft Office Communicator 2007 R2

A host must have a license to start an instant WebEx meeting.

---

6 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
Procedure

Step 1  Open your instant messenger client and select a user from the roster.  
A chat window opens with a WebEx tab on the top.

Step 2  To start a meeting, select the **Start Meeting** button on your WebEx tab.  
Cisco WebEx Meetings launches.

Step 3  To invite a user to your meeting, select the user from your IM roster.  
A chat window opens with a WebEx tab on the top.

Step 4  Select **Invite to Meeting** from the WebEx tab.  
The meeting link is sent to the user.

**Note**  If you already started a WebEx meeting from another interface, such as the website or the Outlook integration, you can still invite users from your instant messenger client by selecting them from your IM roster and using the **Invite to Meeting** button.

Allowing Another User to Schedule Meetings for You

You can grant permission to one or more users to schedule meetings on your behalf by using the Cisco Webex Productivity Tool for Outlook. Once a user schedules a meeting for you, the meeting appears in the list of meetings. You can then start the meeting and host it as you normally do when you schedule meetings yourself.

**Before You Begin**
This task assumes the following:

- You have both Microsoft Outlook and Cisco WebEx Productivity Tool for Outlook installed.
- The user who will be scheduling meetings for you has an account on your WebEx site.
- A host must have an installed or temporary license to schedule a meeting.

**Procedure**

Step 1  Sign in to your WebEx site.  
The **Meetings** page appears.

**Note**  If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2  Select **My Account** in the top right.  
The **My Account** page appears.

Step 3  Scroll down to the Session Options section.

Step 4  For Scheduling Permission, enter the email addresses of users you permit to schedule meetings on your behalf.

Step 5  Select **Update**.
Finding a Meeting

Procedure

Step 1  Sign in to your WebEx site. The Meetings page appears.

Note: If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2  Select the All Meetings tab.

By default, the All Meetings page displays up to 50 meetings for which you are the host, including meetings that are in-progress, are upcoming, and have passed the scheduled starting times but have not been started. If you want to view the list of meetings you are invited to, select this option from the drop-down list.

By default, the All Meetings page displays up to 50 meetings within the next three months for which you are the host, including meetings that are in-progress or are upcoming. If you want to view the list of meetings you are invited to, select this option from the drop-down list.

If a meeting has been started and ended, it will be deleted from the Meetings page. If a recording is available for that meeting, you can find it on the Recordings page.

Step 3  Enter your search parameters.

You can search for meetings by choosing a date range, entering the host name, or topic.

Step 4  Select Search.

The meeting list updates with your search results.

Step 5  To see more results, select Show more meetings.

Editing a Meeting

This task describes how to edit a single meeting. To edit a recurring meeting, see the Editing a Recurring Meeting topic.

Before You Begin

Updating a recurring meeting updates all occurrences of the meeting.

Procedure

Step 1  Sign in to your WebEx site. The Meetings page appears.

Note: If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2  Select the topic of the meeting that you want to edit.
The meeting details page appears.

**Step 3** Select **Edit**.
The *Edit WebEx meeting* page appears.

**Step 4** Modify the meeting parameters.

**Step 5** Select a save option:

- **Save and Notify Updated Invitees**—Saves your updates and sends an updated meeting notification to updated invitees.

- **Save Only**—Saves your updates but does not send an updated meeting notification to your invitees.

The meeting details page appears with a message confirming that your meeting is updated.

---

**Related Topics**

- **Recurrence Pattern Support**, on page 44
- **Editing a Recurring Meeting**, on page 42

---

**Editing a Recurring Meeting**

**Tip**

If you originally scheduled your meeting with Microsoft Outlook, edit your meeting in Outlook to ensure that the meeting information remains synchronized with your Outlook calendar.

---

**Procedure**

**Step 1** Sign in to your WebEx site.
The *Meetings* page appears.

**Note** If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

**Step 2** Select the topic of the meeting that you want to edit.
The meeting details page appears.

**Step 3** Select **Edit**.

**Step 4** Select whether you want to edit a single occurrence of this meeting series or the entire series.
The *Edit Meeting* page appears.
If you make any change to a single occurrence of a meeting series, this occurrence is assigned a new meeting ID from the server. However, as the old meeting ID and link is still valid, this results in two separate meeting rooms becoming available for the one meeting. When invitees join using the old Join Meeting link or join by number they cannot see or be seen by invitees who joined using the updated meeting link. It is very important that you send an updated meeting notification, with the new meeting ID and link, to all your invitees.

If you have deleted a single meeting occurrence from a series, and later edit the entire meeting series, the deleted single meeting occurrence is restored to the meeting list.

**Step 5** Modify the meeting parameters.

**Step 6** Select a save option:

- **Save and Notify Updated Invitees**—Saves your updates and sends an updated meeting notification to updated invitees.
- **Save Only**—Saves your updates but does not send an updated meeting notification to your invitees.

The meeting details page appears with a message confirming that your meeting is updated.

---

**Canceling a Meeting**

You can cancel any meeting you have scheduled from the meeting details page. Canceling a meeting deletes it from the list of meetings on the Meetings page.

---

**Tip**
If you originally scheduled your meeting with Microsoft Outlook, cancel your meeting in Outlook to ensure that the meeting information remains synchronized with your Outlook calendar.

---

**Procedure**

**Step 1** Sign in to your WebEx site.

The **Meetings** page appears.

**Note** If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

**Step 2** Go to the meeting details page by selecting the topic for the meeting or by selecting a link from your confirmation email message.

**Step 3** Select **Delete**.

The **Confirm Delete Meeting** dialog box appears if your meeting lists one or more invited attendees.

**Step 4** Select **Delete**.

- If this meeting is part of a recurring series, select whether you want to delete this occurrence only or the entire meeting series.
- If this meeting had any invitees, select whether or not to send a cancellation email message to all invited attendees.
A confirmation message displays indicating that you have deleted the meeting.

**Step 5**
For meetings that list invited attendees, select whether or not to send a cancellation email message to all invited attendees and then select OK.

---

## Recurrence Pattern Support

If you have a meeting that occurs on a regular basis, such as a monthly company meeting or weekly status meeting, you can set it up as a recurring meeting. Scheduling a recurring meeting allows you to set up the meeting once for the entire meeting chain.

**Note**
If there is an overlap between back-to-back recurring meetings, such as the first meeting ending after the second meeting has started, the second meeting occurrence is deleted from the series. The next meeting shown in the list is the third meeting. To avoid this happening, do not stay in the first meeting beyond the original allotted time.

The following table describes the supported WebEx recurrence patterns:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Repeats the meeting every day until the ending date that you select.</td>
</tr>
<tr>
<td></td>
<td>* Every [x] days: Repeats the meeting after the specified number of days pass.</td>
</tr>
<tr>
<td></td>
<td>* Every weekday: Repeats the meeting each day, from Monday to Friday.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Repeats the meeting every week until the ending date that you select.</td>
</tr>
<tr>
<td></td>
<td>* Every [x] week(s) on: Repeats the meeting every specified number of weeks on the chosen day.</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Monthly</td>
<td>Repeats the meeting every month until the ending date that you select.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Day [x] of every [x] months</strong>: Specifies the specific day of the month on which to repeat the meeting, and the number of months that pass before the meeting repeats.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Every [x] of the [x] week of every [x] month(s)</strong>: Specifies the specific week and day of the week on which to repeat the meeting, and the number of months that pass before the meeting repeats.</td>
</tr>
<tr>
<td>Ending</td>
<td>• <strong>No end</strong>: Repeats the meeting for 10 years.</td>
</tr>
<tr>
<td></td>
<td>• <strong>End by</strong>: Specifies the last day on which the meeting recurs.</td>
</tr>
<tr>
<td></td>
<td>• <strong>After [x] meetings</strong>: Specifies the number in the meeting series after which the meeting stops recurring.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Scheduling a Meeting from the WebEx Site, on page 35
- Editing a Meeting, on page 41
- Editing a Recurring Meeting, on page 42
Using a Mobile Device to Schedule or Join a Meeting

Use your mobile device to schedule or join a meeting from any location. Download the Cisco WebEx app to your mobile device and activate the service, then sign in to Cisco WebEx in the usual manner and you're ready to schedule or attend meetings.

- Downloading Cisco WebEx Meetings on a Mobile Device, page 47
- Activating Cisco WebEx Meetings on a Mobile Device, page 48
- Signing In to WebEx Using a Mobile Device, page 48
- Starting a Meeting with a Mobile Device, page 49
- Joining a Meeting With a Mobile Device, page 49
- Installing a SSL Certificate on a Mobile Device, page 49

Downloading Cisco WebEx Meetings on a Mobile Device

Go to your Cisco WebEx site and select Downloads on the top right of the page. Navigate to the WebEx for Mobile Devices section and select Continue. An activation email is sent to you.

- Apple iPhone or iPad: Make sure to download the app from the Apple Store using the link in your email. Alternatively, you can launch the Apple App Store on your iPhone or iPad and search for "Cisco WebEx Meetings". You'll find this app in the Meet Anywhere category.
- Android devices: Make sure to download the app from Google Play or the alternative link provided.

Note

Your administrator must configure the system to display the option to download WebEx for mobile devices before you can see it on your WebEx site.
Activating Cisco WebEx Meetings on a Mobile Device

Selecting Continue for the Cisco WebEx for Mobile Devices option on the Downloads page causes the system to send an activation email to your account. Select the link in your activation email to complete the activation process. If you haven’t yet downloaded the WebEx app, the activation link will prompt you to download it from the appropriate site.

- Apple iPhone or iPad: After downloading the app, return to your email and select the activation link again.
- Android devices: Your app will launch automatically after installation. Sign in to finish the activation process.

Note: Your administrator must have enabled the mobile feature for your organization before you can use WebEx on your mobile device.

Signing In to WebEx Using a Mobile Device

There are several ways to sign in to WebEx depending on how your system is configured. The application will guide you through the sign in process, but here are a few tips:

- If you get an email to activate your WebEx app, select the contained link to activate your service, then enter the email address associated with your WebEx account and your WebEx password to sign in.

- If you’re prompted to sign in through your corporate website, enter your WebEx site URL, click Next, then enter your user credentials to sign in.

Tip: If your WebEx site is configured for single sign-on (SSO), make sure that you enter your corporate user credentials to sign in. If your WebEx site is not configured for SSO, enter your WebEx user credentials.

- If you have access to multiple WebEx sites, the system will prompt you to choose one after you sign in.

- To join a WebEx meeting you are invited to open the meeting invite in your email inbox or from your Calendar app. Tap on the meeting link in that invite to launch WebEx in your web browser. Optionally, you will be prompted to enter a meeting password. After providing your password, you will be taken to the meeting.

Tip: If you are not signed in to the WebEx app, the option to join by meeting number is not supported unless you have previously signed in from your mobile device.
Starting a Meeting with a Mobile Device

As a host, you can easily schedule, start, and invite others to your WebEx meetings from your mobile device.

---

**Note**

You cannot record a WebEx meeting that is scheduled or started with an iPhone or iPad.

---

**Procedure**

1. Go to the **My Meetings** screen.
2. Select the + icon in the upper right corner of the **Meeting** pane.
3. Enter your meeting title, date and time, and then select your desired attendees. If the meeting is starting soon, you can start your meeting from here.
4. To start a meeting, select **Start**.
5. (Optional) To schedule a meeting for later, tap **Schedule**. You are returned to the **My Meetings** screen.

Joining a Meeting With a Mobile Device

Make sure that you have the Cisco WebEx Meetings app installed on your mobile device, then join your WebEx meeting using one of the following methods:

- Go to your WebEx meeting invitation email and select the link to join the meeting.
- Sign in to your WebEx account and join from the **My Meetings** page.
- Sign in to your WebEx account and use the **Join by Number** feature by entering the meeting number.

Installing a SSL Certificate on a Mobile Device

If your company uses a self-signed certificate or if the root certificate installed on your Apple iPhone or iPad is not on the Apple trusted Certificate Authority list, you must install a SSL certificate on your mobile device before you join a WebEx meeting.

**Before You Begin**

An administrator must send you a certificate file attached to an email message.

Users must have an active high-speed Internet connection for their mobile devices.
**Procedure**

**Step 1** From your iOS email account, open the email from your administrator and save the certificate file to your mobile device.

**Step 2** Install the certificate on your mobile device.
   a) Tap **Install** on the Install Profile page.
   b) Tap **Install Now** on the Unsigned Profile dialog.
   c) Enter the certificate password.
   d) Tap **Next**.
   e) Tap **Done**.
Scheduling WebEx Meetings with Microsoft Outlook

• About WebEx Integration to Outlook, page 51
• Scheduling a WebEx Meeting from Microsoft Outlook, page 52
• Starting a Scheduled Meeting from Microsoft Outlook, page 54
• Recurrence Pattern Support in WebEx Integration to Outlook, page 55
• About Delegates, page 56
• Assigning a Delegate on the WebEx Site, page 57
• Assigning a Delegate in Microsoft Outlook, page 58
• Scheduling a Meeting or an Appointment for Another Host, page 58
• Starting a Meeting for Another Host, page 59
• Editing a Scheduled Meeting, page 60
• Canceling a Meeting in Microsoft Outlook, page 61
• Before You Join a Meeting, page 62
• Joining a Meeting From an Email, page 63
• Joining a Meeting From the Meetings Page, page 64
• Joining By Meeting Number, page 65

About WebEx Integration to Outlook

WebEx Integration to Outlook provides a convenient way for you to schedule or start online meetings using Microsoft Outlook. Using Integration to Outlook, you can perform these activities without the need to use your WebEx site—that is, the site where you normally schedule and join your online meetings.

WebEx Integration to Outlook is a WebEx Productivity Tool for Microsoft Outlook. If your administrator has configured it, you can choose to install Productivity Tools from the Downloads link on your WebEx site.
Depending on system configuration, Productivity Tools can automatically update when new versions are available.

Once Productivity Tools are installed, WebEx integration options appear in Microsoft Outlook allowing you to quickly schedule an online meeting.

**Note**

Before you use WebEx Integration to Outlook, ensure that:

- You have a user account on your WebEx site
- You are familiar with Microsoft Outlook
- You are using a supported version of Microsoft Outlook:
  - Microsoft Outlook 2007 SP2 and later
  - Microsoft Outlook 2010 (32-bit and 64-bit editions; all Service Packs)
  - Microsoft Outlook 2013

When scheduling a meeting, you can invite people using any of your Outlook address lists, including the Global Address List, Personal Address List, or Contacts folder. People whom you invite to a meeting do not need to use Integration to Outlook to join the meeting.

---

**Scheduling a WebEx Meeting from Microsoft Outlook**

To schedule an online meeting using WebEx Integration to Outlook, open a new Meeting Request or Appointment window in Outlook, and then specify information and settings for the meeting.

**Before You Begin**

Be aware of the following:

- Integration to Outlook does not support all of the recurrence options that are available in Microsoft Outlook.

- In any meeting invitations that you send from Microsoft Outlook, the meeting's starting time appears in the time zone that is set on your computer, not in your WebEx account preferences.

  On your WebEx site, all meeting times appear in the time zone that you set in your site preferences, regardless of the time zone that is set on your computer.

- Since you are scheduling the meeting from Microsoft Outlook, any users you invite as alternate hosts will receive two meeting notifications:
  - one inviting them as an invitee with the Join the Meeting link
  - one inviting them as an alternate host with the Start the Meeting link

  Your invitees can use either link to enter the meeting. If you schedule the meeting from the web, users you invite as alternate hosts will receive just one email notification with a link to start the meeting.
Procedure

Step 1  From your Microsoft Outlook client, open a new meeting request by doing one of the following:
- Choose New > Meeting Request or New > Appointment.
- Select Schedule Meeting from the WebEx menu.

A Meeting scheduling window appears with the Add WebEx Meeting ball in the WebEx menu.

Step 2  Enter your meeting details, such as the meeting subject and start and end times, and invite attendees.
To specify a recurrence pattern for your meeting, click Recurrence, and then select recurrence options.

Step 3  Select Add WebEx Meeting from the WebEx menu.
The WebEx Settings dialog box appears.

Note  If the WebEx Settings dialog box does not appear, sign in to WebEx Assistant and select the Add WebEx Meetings icon again.

Step 4  (Optional) If you want to change the meeting type, select it in the Meeting Information section.
Setup by your administrator, the meeting type determines the various conferencing features and options enabled for the meeting. For example, recording may or may not be available for a given meeting type.

Step 5  (Optional) If you want to include a password for your meeting, enter it in the Meeting Information section.

Step 6  (Optional) If you want to grant other users the permission to start your meeting on your behalf, select the Alternate Host tab and select them from the list. You must first add them to your list of attendees before selecting them.

Note  If your organization relies on single sign-on (SSO) and your administrator changes the email address of your alternate host, you may get a message that the email address is not found. Until the new email address is propagated during the daily synchronization between Exchange, Outlook, and CWMS, you will not be able to designate an attendee with a modified email address as an alternate host or to schedule a meeting as a delegate.

Step 7  (Optional) On the Audio Conference tab select your audio conference type.

Note  The audio options can be changed only by changing the meeting type. The available options are indicated by a green checkmark. Unavailable options are indicated with a red cross.

- WebEx Audio - This audio connection mode lets meeting hosts and participants join the online portion of the meeting using the link provided in the meeting email invitation message. Once connected to a meeting, users can either call in to the meeting or use the Call Me feature to receive a call at a number they have provided. This option requires a host to schedule a meeting with either the Meet Now feature or the scheduler.

- Personal Conferencing - This audio connection mode lets a meeting host quickly start the audio portion of a Cisco WebEx meeting at any time. The meeting host and participants simply dial the same call-in number, enter access codes, and the audio portion of the meeting begins. The system then sends an email to the meeting host with a link to the online portion of the meeting. If the host chooses to start the online meeting, participants can then use it to share information or collaborate on an idea. The meeting host is not required to schedule Personal Conferencing meetings in advance, and once generated, the access codes do not change.

Note  You must have a Personal Conference account and a host PIN to use the Personal Conferencing option.

Step 8  Select OK to close the WebEx Settings dialog box.
WebEx information displays in your Microsoft Outlook appointment form.

**Step 9** Select **Send** to save your meeting information and send email invitations to invitees. The scheduled meeting displays in your Outlook calendar and the list of meetings on your WebEx Meetings page.

**Related Topics**
- Recurrence Pattern Support in WebEx Integration to Outlook, on page 55
- Allowing Another User to Schedule Meetings for You, on page 40
- About Scheduling a Meeting for Another Host

**Starting a Scheduled Meeting from Microsoft Outlook**

**Procedure**

**Step 1** In Microsoft Outlook, double-click the meeting entry from the Outlook calendar. The meeting notification appears.

**Step 2** Select the link to start your meeting.

**What to Do Next**

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select **Download** and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.*

**Note**

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option and select **Done**.
- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.
Recurrence Pattern Support in WebEx Integration to Outlook

**Note**

If you use WebEx Integration to Outlook to modify meeting settings for a recurring meeting, you must apply the changes to the entire series of the meeting. If you apply the changes to just a single occurrence of the meeting, the changes will show only in Outlook, not on your WebEx site.

Invitees attempting to join meetings tied to the changed single occurrence can incorrectly be notified that the meeting has not yet started unless the host of that meeting occurrence explicitly joins the meeting to start at the scheduled time.

There is a known issue whereby the system skips recurring meeting instances that were not attended. For details, see Meeting Details Page Displays Incorrect Information, on page 107.

The following table shows how Outlook recurrence patterns are handled in WebEx:

<table>
<thead>
<tr>
<th>Type</th>
<th>Outlook Option</th>
<th>Converted to WebEx Meeting Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Every [x] days</td>
<td>Every [x] days</td>
</tr>
<tr>
<td></td>
<td>Every weekday</td>
<td>Every weekday</td>
</tr>
<tr>
<td>Weekly</td>
<td>Every [x] weeks on: [Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday]</td>
<td>Every [x] weeks on: [Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday]</td>
</tr>
<tr>
<td>Monthly</td>
<td>Day [x] of every [y] months</td>
<td>Day [x] of every [y] months</td>
</tr>
<tr>
<td></td>
<td>The [first, second, third, fourth, last] day of every month</td>
<td>Day [1,2,3,4,31] of every month</td>
</tr>
<tr>
<td></td>
<td>The [first, second, third, fourth, last] weekday or weekend day</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>The [first, second, third, fourth, last] Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday of every [x] months</td>
<td>The [first, second, third, fourth, last] Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday of every [x] months</td>
</tr>
<tr>
<td>Yearly</td>
<td>Every [January....December] [1,...31]</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>[first, second,third, fourth, last] [day,weekday,weekend day] of [January....December]</td>
<td>Not supported</td>
</tr>
</tbody>
</table>
### Related Topics

*Scheduling a WebEx Meeting from Microsoft Outlook, on page 52*

### About Delegates

WebEx Integration to Outlook supports the concept of having one user, a delegate, complete scheduling activities on behalf of another user. These activities can include scheduling, editing, canceling, and starting meetings. For example, if you must host WebEx meetings on a regular basis, you can give your assistant permission to complete these activities for you by assigning this person as your delegate.

**Things to Know Before Assigning a Delegate**

- If you do not see the option to assign a delegate on your WebEx site, enable the **Scheduling Permission** option on your **My Account** page.
- Your delegate must also have an active WebEx host account on your WebEx site.
- The email addresses for both your and the delegates' accounts on your WebEx site must match those in Microsoft Outlook.
- Meetings that your delegate schedules appear in your calendar. If you want to edit them, you must have WebEx Integration to Outlook installed on your computer.
- You can remove scheduling permission from your delegate at any time.
- The **Scheduling Permission** option applies only to WebEx Audio meetings. Another user cannot schedule Personal Conference meetings on your behalf.

**Things to Know If You Are Assigned to Be a Delegate**

Before you schedule a meeting for another host, ensure that:

- You have a WebEx host account. To obtain a WebEx host account, contact your administrator.
- The WebEx Integration to Outlook add-in is installed.
- The actual host does the following:
  - Gives you scheduling permission on the WebEx site.
  - Selects you as a delegate in Microsoft Outlook and shares his or her calendar with you.
After scheduling a meeting on behalf of another host, you can also start the meeting for that host, if necessary.

At any time, the actual host can remove scheduling permission from you.

Related Topics
Assigning a Delegate on the WebEx Site, on page 57
Assigning a Delegate in Microsoft Outlook, on page 58
Scheduling a Meeting or an Appointment for Another Host, on page 58
Starting a Meeting for Another Host, on page 59

Assigning a Delegate on the WebEx Site

The following task describes how to grant scheduling permissions to your delegate on the WebEx site.

Procedure

Step 1 Sign in to your WebEx site. The Meetings page appears.

Note If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2 Select My Account in the top right. The My Account page appears.

Step 3 Scroll down to the Session Options section.

Step 4 For Scheduling Permission, enter the email addresses of users you are assigning as a delegate.

Note Users must have host privileges in Cisco WebEx before you can assign them as delegates.

Step 5 Click Update.

What to Do Next
In Microsoft Outlook, select the delegate and share your calendar with him or her.

Related Topics
Assigning a Delegate in Microsoft Outlook, on page 58
About Delegates, on page 56
Assigning a Delegate in Microsoft Outlook

The following task describes how to share your Microsoft Outlook calendar with your delegate. These steps assume that you are using Microsoft Outlook 2010. Since the exact steps for this task may vary based on your version of Outlook, refer to your Outlook Help documentation for details.

Before You Begin

- Make sure that you have granted scheduling permission to your delegate from your WebEx My Account page.
- Ensure that the calendar you share does not reside in your personal folder in Microsoft Outlook. Your delegate can access your calendar only if it resides in a public folder.
- The name of the delegate you want to assign must be in the Global Address List in your Microsoft Outlook.

Procedure

Step 1 From Microsoft Outlook, select File > Account Settings > Delegate Access. The Delegates window appears.

Step 2 Select Add. The Add Users window appears.

Step 3 Select the delegate's name, then click Add.

Step 4 Click OK. The Delegate Permissions dialog box appears.

Step 5 For Calendar, select Editor then click OK.

Step 6 Select OK to close the Options dialog box.

Related Topics

Assigning a Delegate on the WebEx Site, on page 57
About Delegates, on page 56

Scheduling a Meeting or an Appointment for Another Host

Before You Begin

This task assumes the following:
- You are a delegate of the host on whose behalf you are scheduling.
- The other host has shared his or her calendar with you.
- You are scheduling a WebEx Audio meeting on behalf of your host.
Procedure

Step 1
Open the other host's calendar in Microsoft Outlook by doing the following:

a) Select File > Open > Other User's Folder.
   The Open Other User's Folder dialog box appears.

b) Type the name of the actual host or click Name to select his or her name.

c) For Folder type, select Calendar, then click OK.
   The shared calendar appears.

Note: There are multiple ways of opening another user's calendar depending on how you customize your views in Microsoft Outlook. For details, see the Microsoft Outlook Help.

Step 2
If you are viewing multiple calendars side by side, ensure that you select the actual host's calendar by clicking it once.

Step 3
Open a new meeting request in Outlook, and then specify information and settings for the meeting.

Related Topics

Scheduling a WebEx Meeting from Microsoft Outlook, on page 52
About Delegates, on page 56

Starting a Meeting for Another Host

Once you schedule a meeting for another host, the other host receives a confirmation email message in his or her Microsoft Outlook. Complete this task to start the meeting from the other host's calendar.

Before You Begin
This task assumes that you have access to the other host's Microsoft Outlook calendar.

Procedure

Step 1
Open the other host's calendar in Microsoft Outlook by doing the following:

a) In Microsoft Outlook, select File > Open > Other User's Folder.
   The Open Other User's Folder dialog box appears.

b) Type the name of the other host or click Name to select his or her name.

c) For Folder type, select Calendar, then click OK.
   The shared calendar appears.

Note: There are multiple ways of opening another user's calendar depending on how you customize your views in Microsoft Outlook. For details, see the Microsoft Outlook Help.

Step 2
Double-click the meeting item in the other host's calendar.
The confirmation email message appears.
What to Do Next

To start the meeting, follow the instructions in the email message and ensure that you sign in to your own WebEx host account on the WebEx site.

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select Download and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.

Note

After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the Always allow plug-ins... option and select Done.

- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select Allow and Remember.

If the meeting does not start automatically, refresh the page.

Editing a Scheduled Meeting

Once you schedule a meeting using WebEx Integration to Outlook, you can use Outlook to edit it at any time. For example, you can change its starting time, specify a new password, or choose an alternate host. Once you edit a scheduled meeting, Integration to Outlook sends an updated meeting invitation to any invitees and also updates the meeting information on your WebEx site.

If you edit a recurring meeting, the following limitations apply:

- If you update a single occurrence of a meeting series, you cannot select Add WebEx Meeting. We recommend that you schedule a new meeting or change the entire recurring meeting series so that you can select Add WebEx Meeting.

- If you reschedule or cancel a single occurrence of a recurring WebEx meeting using Microsoft Outlook, the changes show only in Outlook, not on your WebEx site. For example, if you change the starting time of a single occurrence of a recurring WebEx meeting in Outlook, attendees can still join the meeting at the old starting time. Therefore, if you want to modify a recurring meeting using Outlook, we recommend that you apply the changes to the entire series of the meeting.

- When you edit a single occurrence of the meeting series by changing the meeting topic, list of attendees, or location, then edit the meeting content in the entire recurring meeting series, any changes made to the series are not reflected in the meetings that were edited separately.

- If you schedule a WebEx meeting from Microsoft Outlook and the meeting time passes. Then you drag one instance of the series to a time in the past and update it to reflect a time in the future, the WebEx component of the meeting remains the same. It cannot be updated to reflect a future time.

- If you edit a single occurrence of a meeting series, this occurrence is assigned a new meeting ID from the server. It is important that you send an updated meeting notification, with the new meeting ID and link, to all your invitees.
Before You Begin

- If you edit a WebEx meeting from the WebEx site, your changes won't show in Microsoft Outlook. Make sure that you use the same scheduling interface for both scheduling and editing WebEx meetings.

- If you reschedule or cancel a single occurrence of a recurring WebEx meeting using Microsoft Outlook, the changes show only in Outlook, not on your WebEx site. For example, if you change the starting time of a single occurrence of a recurring WebEx meeting in Outlook, attendees can still join the meeting at the old starting time. Therefore, if you want to modify a recurring meeting using Outlook, we recommend that you apply the changes to the entire series of the meeting.

Procedure

**Step 1**
On your Microsoft Outlook calendar, open the item for the scheduled meeting.

**Step 2**
Edit the meeting information or change options on either the toolbar or on the Appointment tab. For example:

- To change the WebEx meeting settings, select **Change Settings**.
- To remove the WebEx meeting settings previously set, select **Cancel WebEx Meeting**.
- To add or change a recurrence pattern, select **Recurrence**.
- To edit the text in the meeting invitation email message, do it on the Appointment tab.

**Step 3**
Do one of the following, as appropriate:

- To send the updated meeting invitation to invited attendees and save the updated meeting in your Outlook calendar, select **Send Update**.
- To save the updated meeting to your Outlook calendar, select **Save and Close**.

Your meeting is updated in both your Microsoft Outlook calendar and the WebEx site.

## Canceling a Meeting in Microsoft Outlook

**Procedure**

**Step 1**
Open the meeting item in Microsoft Outlook.

**Step 2**
Select **Delete**.

**Step 3**
Choose whether to notify invitees or not, and then click **OK**.

**Step 4**
Click **OK** in the confirmation box.

The meeting is removed from your Outlook calendar and your WebEx site. A message appears confirming that your meeting was removed from the site.
Before You Join a Meeting

This section describes some of the things you might experience when you join a meeting.

The size of your system determines the maximum number of people who can join a meeting. When number of meeting participants reaches the maximum size, users who try to start new meetings or join meetings see an error message and the system prevents them from starting or joining a meeting. Users who dial into the meeting hear an audio prompt indicating that he or she cannot start or join a meeting because the system has reached the maximum participant capacity.

For any meeting, only half of the maximum number of participants can use video. Video is defined as sending or receiving, meaning users are using their WebEx webcam video or the video file share option which allows them to share a video.

If your WebEx site uses self-signed certificates instead of certificates from a well-known Certificate Authority, after your data center is joined to another data center users must install a certificate for each data center in the Trusted Root Certification Authorities store before they start or join a meeting.

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select Download and follow the instructions to install the required plug-in.

After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the Always allow plug-ins... option and select Done.
- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select Allow and Remember.

If the meeting does not start automatically, refresh the page.

If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you might be required to complete the following one-time installation to add the Cisco WebEx extension to your Chrome browser:

1. Select Add WebEx to Chrome.
2. Select Free on the Cisco WebEx Extension dialog.
3. Select Add to add the Cisco WebEx extension to your Chrome browser.
4. Open the Cisco_WebEx_Add-on.exe file and select Run.
5. The page refreshes when the installation has finished. If the meeting does not start automatically, refresh the page.

---

Note 7 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
Joining a Meeting From an Email

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Open your email invitation, then select the link. The meeting details page appears for the meeting you are joining.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>If you are joining a meeting that is part of a recurring series, the meeting details page may reflect the incorrect date. This is a known issue and will not impact your ability to join your current meeting from this page.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
<th>If requested, enter the required information. Details you may need to enter include the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Your name: Enter the name you want attendees to use to identify you during the meeting.</td>
<td></td>
</tr>
<tr>
<td>• Email address: Enter your email address in this format: name@your_company. For example, <a href="mailto:msmith@company.com">msmith@company.com</a>.</td>
<td></td>
</tr>
<tr>
<td>• Meeting password: Enter the meeting password. The meeting host may have included the password in the email invitation or, for security reasons, provided it to you in another way.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 3</th>
<th>Select Join.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• If you are already signed in or do not have an account on this WebEx site, wait for the meeting client to launch.</td>
<td></td>
</tr>
<tr>
<td>• If you are not signed in but you do have an account on this WebEx site, the system will redirect you to a sign-in page where you can enter your user credentials before joining your meeting.</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>If your site is configured for single sign-on (SSO), the sign-in page will be on your company's SSO site. If your site is not configured for SSO, you will sign in through the WebEx sign in page.</td>
</tr>
</tbody>
</table>

What to Do Next

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select Download and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option and select **Done**.

- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.

If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you might be required to complete the following one-time installation to add the Cisco WebEx extension to your Chrome browser:

1. Select **Add WebEx to Chrome**.
2. Select **Free** on the Cisco WebEx Extension dialog.
3. Select **Add** to add the Cisco WebEx extension to your Chrome browser.
4. Open the Cisco_WebEx_Add-on.exe file and select **Run**.
5. The page refreshes when the installation has finished. If the meeting does not start automatically, refresh the page.

If you are not automatically prompted by the system, select **Audio Conference** to join the audio portion of your meeting.

### Joining a Meeting From the Meetings Page

#### Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Sign in to your WebEx site. The <strong>Meetings</strong> page appears.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Locate your meeting in the Today list. If your meeting is not visible, select the <strong>All Meetings</strong> tab and enter your search parameters to locate it.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Select <strong>Join</strong>.</td>
</tr>
</tbody>
</table>

#### What to Do Next

If you are using Chrome 32 and later or Firefox 27\(^9\) and later, you might see a prompt to install a Cisco WebEx plug-in. Select **Download** and follow the instructions to install the required plug-in.

---

\(^9\) The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.

**Note**

After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the *Always allow plug-ins...* option and select **Done**.

- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.

If you are not automatically prompted by the system, select **Audio Conference** to join the audio portion of your meeting.

## Joining By Meeting Number

You can join a meeting by using the meeting number whether you are signed in to Cisco WebEx or not.

### Procedure

Complete one of the following:

<table>
<thead>
<tr>
<th>If You are already signed in to your WebEx site</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure that you are on the Meetings page by selecting the <strong>Meetings</strong> tab.</td>
<td>1</td>
</tr>
<tr>
<td>Select <strong>Join by Number</strong>.</td>
<td>2</td>
</tr>
<tr>
<td>Enter the meeting number.</td>
<td>3</td>
</tr>
<tr>
<td>Enter the meeting password, if requested.</td>
<td>4</td>
</tr>
<tr>
<td>Select <strong>Join</strong>.</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>If You are not signed in to your WebEx site</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open your web browser and navigate to your WebEx site.</td>
<td>1</td>
</tr>
<tr>
<td>Select the <strong>Join by Number</strong> link in the top right of the header.</td>
<td>2</td>
</tr>
<tr>
<td>Enter the requested information on the Join by Number page.</td>
<td>3</td>
</tr>
<tr>
<td>Select <strong>Join</strong>.</td>
<td>4</td>
</tr>
</tbody>
</table>

**Tip** You can also access the Join by Number page by entering your public WebEx site URL followed by /orion/join, for example, https://<public site url>/orion/join
If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select **Download** and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.

**Note**  
After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option and select **Done**.

  - If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.

**Troubleshooting Tips**

If you cannot join the meeting by using the meeting number, do the following:

- Make sure that you are entering the correct meeting number.

  - Make sure that it is the correct time to join the meeting.

  - If your information is correct, search for the meeting on the Meetings page and try to join from the link.
Starting or Joining a Blast Dial Meeting

The Blast Dial feature lets a meeting host start a meeting quickly with a predetermined group of people.

• Downloading the Group and Participants Templates, page 67
• Starting a Blast Dial Meeting, page 68
• Joining a Blast Dial Meeting, page 69

Downloading the Group and Participants Templates

The host of a Blast Dial group uses the links provided to download the Group and Participants templates. Send the completed templates to the Administrator who will create your Blast Dial Group.

**Important**

Only the person designated as a host for a Blast Dial group should download and complete these templates.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Sign in to your WebEx site.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Select the My Account link.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Blast Dial Information section, select the GroupTemplate link to download the template a host uses to provide the general settings, such as group name and host PIN, for the new Blast Dial group.</td>
</tr>
</tbody>
</table>

**Tip**

• You can leave the Route Pattern and Call-in Number fields blank. Your administrator configures a route pattern and call-in number for each Blast Dial group.

• If you plan to start the online portion of your Blast Dial meeting, consider entering a meeting password to provide extra security for your meeting.

• If you have a large Blast Dial group, consider selecting No Tone for the joining meeting Indicator to provide the best meeting experience.

• The Unlimited Call Attempts option is provided for instances where it is imperative for all participants to join a Blast Dial meeting.

• For the most secure meeting, consider having a 10-digit host PIN and participant PIN.
Step 4 Select the **Participants Template** link to download the template a host uses to provide participants' information, such as email address, for the new Blast Dial group.

**Tip**
- For internal participants, meaning users who have a company email address, only a user's email address is required.
- To make an internal participant a host who can start Blast Dial meetings, enter a 'Y' in the ISHOST column.
- There must be at least one internal participant designated as a host for each Blast Dial group.
- For external participants, enter a first and last name, an email address, and 1-4 phone numbers. If you do not provide a phone number for an external participant, the system does not automatically call this participant when a host starts a Blast Dial meeting. The participant has to call into the meeting by dialing the call-in number and entering a participant PIN.

Step 5 Follow the instructions provided at the top of each template to fill in the required information.

Step 6 Send the completed templates to the administrator who will create the Blast Dial group.

---

**Starting a Blast Dial Meeting**

Use this feature to quickly hold a meeting with a preconfigured group of users. A host can start a Blast Dial meeting any time. After the host calls the Call-in access number and enters a host PIN, the system automatically begins calling the members of the Participants list. For audio only Blast Dial meetings, the meeting ends when the last person in the meeting ends the call. For online Blast Dial meetings, the meeting ends when the host ends the online portion of the meeting.

For Blast Dial online meetings the host cannot edit or delete the online portion of the meeting and participants cannot join the meeting before the host.

**Before You Begin**

- You must be configured as a Blast Dial host to start a Blast Dial meeting.
- Only a host with a license can start a Blast Dial meeting.
- Hosts receive an email notification with the Call-in number and host PIN (if configured) when the Administrator creates a Blast Dial group.
- Participants receive an email notification with the Call-in number, participant PIN (if configured) when the Administrator creates a Blast Dial group.
- The Blast Dial Information section on your **My Account** page provides the Call-in number and PIN information for each Blast Dial group in which you are a host or a participant.
- A host can call into an in-progress Blast Dial meeting and enter either a host PIN or participant PIN to join the meeting.

---

*Cisco WebEx Meetings Server User Guide Release 2.8*
Safeguard your host PIN. Anyone who knows the call-in number and host PIN can start or join a Blast Dial meeting.

Note
During the audio portion of a Blast Dial meeting you can enter the following audio key shortcuts on the keypad of your phone or mobile device:

- *1 Dialout (host only)
- *5 Lock or unlock (host only)
- *6 mute self or unmute self
- ## Mute all participants (host only)
- 99 Unmute all participants (host only)
- *# Play participant count
- #7 End meeting (host only)
- ** DMTF help

Note
The audio key shortcuts are only available during the audio portion of the Blast Dial meeting. When the host launches the online portion of the meeting, these actions must be completed in the meeting client.

Procedure

Step 1
A host calls the Call-in number indicated in your email notification or My Accounts page.

Step 2
Enter the host PIN.
The meeting starts immediately. The system automatically calls the list of participants for this Blast Dial group and sends an email notification with the URL for the web portion of the meeting.

Note
If several host are configured for a Blast Dial group, the host who calls the access number and enters the host PIN first is the host of the meeting. The other hosts join the meeting by answering the system generated Blast Dial call and enter the host PIN.

Step 3
(Optional) Start the online portion of the meeting by selecting the URL in your email notification.

Note
Any user with host privileges can start the online portion of the meeting.

Step 4
(Optional) Enter a meeting password, if required, when you access the online portion of the meeting. This password is provided in your email notification.

Joining a Blast Dial Meeting

The system calls participants to join a Blast Dial meeting. If participants miss the call or they want to join an in-progress Blast Dial meeting, they dial the call-in number indicated in the email invitation and enter the participant PIN.
Unlike other types of Cisco WebEx meetings, a Blast Dial meeting continues until the last person in the meeting ends the call or hangs up his or her phone.

Before You Begin

- Participants receive an email notification with the call-in number, participant PIN (if required), and meeting password (if required) when an Administrator adds you to the Participants list for a Blast Dial group.
- The Blast Dial Information section on your My Account page provides the call-in number and PIN information for each Blast Dial group in which you are a host or a participant.
- Only a host with a host PIN can start a Blast Dial meeting.
- Only a host can start the online portion of a Blast Dial meeting.

Note

Safeguard your host PIN. Anyone who knows the call-in number and host PIN can start or join a Blast Dial meeting. Likewise, anyone who knows the call-in number and participant PIN can join an in-progress Blast Dial meeting.

Procedure

Step 1 When you answer a Blast Dial call, enter a participant PIN to join the meeting.
If you are a host but did not start the meeting, when you receive a Blast Dial call enter either the host PIN or participant PIN to join the meeting.
You are connected to the audio portion of the meeting.

Step 2 (Optional) To join the online portion of the meeting, select the URL indicated in your email notification.
Note A host must start the online portion of the meeting before you can join it.

Step 3 (Optional) Enter a meeting password, if required.
CHAPTER 9

Managing Meeting Recordings

Meetings that you record on the server are automatically listed on the **Meeting Recordings** page. Note that the recordings you see are limited to meetings you scheduled. If you are an alternate host for a particular meeting, you will not see its recording on your Recordings page nor will the system send you an email notification when the recording is ready even if you are the user who started the meeting or the recording. Contact the meeting scheduler if you require a recording for any meeting that you did not schedule.

- Recording Your Meeting, page 71
- Finding a Recording, page 72
- Playing a Meeting Recording, page 72
- Downloading a Meeting Recording or WebEx Network Recording Player, page 74
- Sharing a Meeting Recording, page 75
- Deleting a Meeting Recording, page 75

Recording Your Meeting

Recording a meeting is a great way to share meeting content with invitees who could not make the meeting or with other interested people. You can find links to the recordings, for meetings that you scheduled, on the **Recordings** page of your WebEx site. Only the meeting host has recording privileges.

If your administrator enabled the feature, an announcement plays when recording begins, to inform all participants that the meeting is being recorded. For anyone joining the meeting, after the recording starts, a message plays to inform them that the meeting is being recorded.
You cannot start recordings for Personal Conferences unless you start the meeting from the web.

If you select the **Record this meeting** option on the **Schedule Meeting** page, the following notes apply:

- The option is not supported for audio-only meetings (PCN meetings and WebEx meetings attended only by phone users). To have the recording start automatically, the host or an alternate host must start the meeting from the web.
- If an attendee joins the meeting first (before the host or an alternate host starts the meeting from the web), the recording does not start automatically. Only the host and alternate hosts have recording privileges. In this scenario, the host can start the recording manually.
- If the host joins the meeting as a participant, and then uses the Host Key to assume the host role, the recording does not start automatically. In this scenario, the host can start the recording manually.

**Procedure**

To record your meeting, select **Record** located at the top right of the meeting window. Recording begins immediately. You can stop and restart recording during your meeting, but doing so creates multiple recording files. To avoid creating multiple files, simply pause and resume the recording as needed. At the end of your meeting, the recording is saved to a file.

### Finding a Recording

**Procedure**

1. **Sign in** to your WebEx site. The **Meetings** page appears.

   **Note** If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

2. **Select** the **Recordings** tab. The **Meeting Recordings** page appears with the list of available recordings.

3. **Enter** a search term and select **Search**. The recording list updates with your search results.

### Playing a Meeting Recording

**Procedure**

1. **Sign in** to your WebEx site.
The **Meetings** page appears.

**Note**  If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

**Step 2**  Select the **Recordings** tab.  
The **Meeting Recordings** page appears with the list of available recordings.

**Step 3**  Locate the meeting recording that you want to access.  
**Tip**  If the meeting list is too long, search for the recording by entering a search term in the available box then selecting **Search**.

**Step 4**  Do one of the following to play the recording:

- Select the topic name.
- Select the drop-down arrow in the Options column and select **Play**.

The recording launches in a separate window.

---

**What to Do Next**

If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx plug-in. Select **Download** and follow the instructions to install the required plug-in.

*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.*

---

**Note**  After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option, and select **Done**.
- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the playback does not start automatically, refresh the page.

If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you might be required to complete the following one-time installation to add the Cisco WebEx extension to your Chrome browser:

1. Select **Add WebEx to Chrome**.
2. Select **Free** on the Cisco WebEx Extension dialog.
3. Select **Add** to add the Cisco WebEx extension to your Chrome browser.
4. Open the Cisco_WebEx_Add-on.exe file and select **Run**.
5. The page refreshes when the installation has finished. If the meeting does not start automatically, refresh the page.

---

11 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
Downloading a Meeting Recording or WebEx Network Recording Player

Download a meeting recording to play it on a local device or to save it locally for future reference.

Note

If you receive notification to preserve any meeting recordings due to joining data centers, download the recordings to your local PC.

Procedure

Step 1
Sign in to your WebEx site.
The Meetings page appears.

Note
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2
Select the Recordings tab.
The Meeting Recordings page appears with the list of available recordings.

Step 3
Locate the meeting recording that you want to access.

Tip
If the meeting list is too long, search for the recording by entering a search term in the available box then selecting Search.

Step 4
Select the drop-down arrow in the Options column and select Download.
WebEx prepares the recording file for download. If you have not already downloaded the WebEx Network Recording Player, you can download it now by selecting Download Player.

Tip
You can also download the WebEx Network Recording Player from the Downloads link in the upper right corner of your Cisco WebEx site.

Step 5
(Optional) Once you download a recording, double-click the recording in the download area of the browser to start the recording.

Step 6
(Optional) To convert a recording to Windows Media Video (WMV) or Adobe Flash file (SWF), from the Network Recording Player window select File > Convert Format and select the desired format. Complete the fields on the Convert Format dialog.
On the original recording (either streaming or downloaded), video and audio quality is good (24+ frames per second). After converting the recording to WMV or SWF format, you might find that the audio and video appear to be significantly downsampled (5 Frames per second).

The converted file appears in the location you specified in the Save As field. Double-click the .wmv or .swf file to play the recording.
Sharing a Meeting Recording

Procedure

Step 1  Sign in to your WebEx site.
The Meetings page appears.

Note    If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2  Select the Recordings tab.
The Meeting Recordings page appears with the list of available recordings.

Step 3  Locate the meeting recording that you want to access.
Tip     If the meeting list is too long, search for the recording by entering a search term in the available box then selecting Search.

Step 4  Select the drop-down arrow in the Options column and select Share.
The Share Recording window appears.

Step 5  Enter the requested information and select Send.
The system sends an email to the specified users with instructions on how to access the meeting recording.

Note    The system administrator can restrict meeting sharing between CWMS users only.

Deleting a Meeting Recording

Procedure

Step 1  Sign in to your WebEx site.
The Meetings page appears.

Note    If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign in to Cisco WebEx if cookies are disabled.

Step 2  Select the Recordings tab.
The Meeting Recordings page appears with the list of available meeting recordings.

Step 3  Locate the meeting recording that you want to access.
Tip     If the meeting list is too long, search for the recording by entering a search term in the available box then selecting Search.

Step 4  Select the drop-down arrow in the Options column and select Delete.
A Delete Recording confirmation window appears.

Step 5  Select OK to confirm.
The recording is deleted and a confirmation appears at the top of the Meeting Recordings page.
Accessibility

This release of Cisco WebEx Meetings Server has enhanced web page accessibility for both administrator and end-user sites on Windows operating systems including audio CAPTCHA, keyboard support, and screen reader (JAWS) support. Keyboard shortcuts and screen readers are also supported in the meeting client.

- Using Audio CAPTCHA, page 77
- Screen Reader Support, page 78
- Supported Keyboard Shortcuts, page 78
- Working With the Participants List, page 79
- Copying Text From the Chat Panel, page 80
- Entering Text In An Input Box, page 80
- Accessing the Meeting Controls Panel During Sharing, page 81

Using Audio CAPTCHA

The CAPTCHA challenge-response test requires that you accurately enter the text that is presented into the text box so that you can access your account. WebEx presents you with this security measure when you fail to sign in with the correct user credentials six times or when you choose to reset your password by selecting the Forgot your password link. As an alternative to entering what you see in the image, you can enter the text that you hear.

Audio CAPTCHA is not supported if your system is configured for SSO or LDAP authentication.

Procedure

Step 1
Navigate to the Hear an audio challenge link using the Tab or Shift+Tab keys and select Enter. The text will be read to you.

Step 2
Enter the text that you hear into the text box and select Enter.

Step 3
To hear the text again, navigate to the Replay link using Shift+Tab and select Enter.
After entering the text correctly, you can proceed with signing in to WebEx.

**Screen Reader Support**

Cisco WebEx supports JAWS screen reading software for the following elements in the meeting client:

- Application menus and drop-down menus
- Shared file titles and tab titles
- Quick Start page buttons, button titles, and tooltips
- Panel and Panels tray buttons, button titles, and tooltips
- Annotation panel and toolbars
- Shared Meeting window content area toolbars
- Meeting Controls Panel buttons, button titles, and tooltips

**Supported Keyboard Shortcuts**

Windows operating system participants who have special needs or who are power users can navigate around the meeting window using keyboard shortcuts. Some of these shortcuts are standard in the Windows environment.

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Switch between meeting window areas such as the content area and the panels area</td>
</tr>
</tbody>
</table>
| Ctrl+Tab    | • Switch between open documents in the content area of the meeting window  
              • Navigate within the panels area  
              • Switch between tabs in the following windows:  
                • **Invite and Remind**  
                • **Preferences**  
                • **Meeting Options**  
                • **Participant Privileges** |
### Working With the Participants List

The Participants panel provides a right-click menu that allows you to act upon a participant depending on your role in the meeting:

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift+F10</td>
<td>• Use right-click menus in the following panels and elements:</td>
</tr>
<tr>
<td></td>
<td>• Participant panel</td>
</tr>
<tr>
<td></td>
<td>• Chat panel</td>
</tr>
<tr>
<td></td>
<td>• Notes panel</td>
</tr>
<tr>
<td></td>
<td>• Closed Captions panel</td>
</tr>
<tr>
<td></td>
<td>• File Transfer window</td>
</tr>
<tr>
<td></td>
<td>• Shared whiteboard and file tabs</td>
</tr>
<tr>
<td></td>
<td>• Work with the Participants list</td>
</tr>
<tr>
<td></td>
<td>• Copy text from the Chat panel</td>
</tr>
<tr>
<td>Tab</td>
<td>Switch between elements, such as buttons, fields, and check boxes</td>
</tr>
<tr>
<td></td>
<td>within a window or panel</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Switch between options in dialog boxes</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Close any dialog box</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Selecting Alt+F4 is just like selecting the &quot;x&quot; on any</td>
</tr>
<tr>
<td></td>
<td>dialog box.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>• Check or uncheck an option box</td>
</tr>
<tr>
<td></td>
<td>• Enter text in an input box</td>
</tr>
<tr>
<td>Enter</td>
<td>Carry out the command for the active button (usually replaces a</td>
</tr>
<tr>
<td></td>
<td>mouse click)</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select text from the Chat panel</td>
</tr>
<tr>
<td>Ctrl+Alt+Shift</td>
<td>Show the <strong>Meeting Controls</strong> panel when video is in</td>
</tr>
<tr>
<td>Ctrl+Alt+Shift+H</td>
<td>full-screen mode</td>
</tr>
<tr>
<td>Ctrl+Alt+Shift+H</td>
<td>Hide the Meeting controls, panels, and notifications</td>
</tr>
<tr>
<td></td>
<td>when video is in full-screen mode</td>
</tr>
</tbody>
</table>
• If you are the host or presenter, you can perform actions such as making someone else the presenter or muting another participant's microphone if it is too noisy.

• If you are not the host or presenter, you can perform actions such as asking to become the presenter or muting your own microphone.

Procedure

| Step 1 | Press F6 on your keyboard to navigate from the contents area to the Participants panel. |
| Step 2 | Navigate to the appropriate participant by using the up and down arrow keys. |
| Step 3 | Select Shift+F10 to open the right-click menu on the specific participant. |
| Step 4 | Use the up and down arrow keys to navigate between the available options. |

Copying Text From the Chat Panel

The Chat panel provides a right-click menu that allows you to copy text from the Chat history area.

Before You Begin

Make sure that you are in the correct portion of the meeting window by doing the following:

• Press F6 to move from the contents area to the panels area of the meeting window.

• Press Ctrl+Tab to navigate between panels until you are in the Chat panel.

• Press Tab until you are in the Chat history area.

Procedure

| Step 1 | With the focus on the Chat history area, select Shift+F10 to open the right-click menu. |
| Step 2 | Use the up and down arrows to copy text or to select all text. |

Tip

Alternatively, you can use Ctrl+A to select all the chat text.

To select only a portion of the text, move your cursor with the arrow keys and then use Shift-[Arrow] to highlight text.

Entering Text In An Input Box

Note the following tips to enter text in an input box.
Procedure

Step 1
If the window includes questions, navigate between questions using the Tab key.

Step 2
If the window includes options, move between the options using the up and down arrow keys.

Step 3
Move the cursor to focus on the text input area and use the Spacebar or Enter key so you can type your answer.

Step 4
Press Enter or Esc to finish editing.

Accessing the Meeting Controls Panel During Sharing

During sharing, the Meeting Controls panel is partially hidden at the top of your screen. Read the following task to display it during sharing.

Procedure

Step 1
Enter Ctrl+Alt+Shift to show the panel.

Step 2
After the panel is displayed, the initial focus is on the Participants icon.

Do the following:

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Change focus</td>
</tr>
<tr>
<td>Enter</td>
<td>Activate a feature</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Alt+Tab</th>
<th>Return to the sharing area from the Meeting Controls panel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If you are sharing a file, select the WebEx ball to return to the sharing area.</td>
</tr>
<tr>
<td></td>
<td>• If you are sharing an application, select the application to return focus to it.</td>
</tr>
<tr>
<td></td>
<td>• If you are sharing your desktop, select the application you want to share.</td>
</tr>
</tbody>
</table>

Note
To switch from the Meeting Controls panel to another open panel, such as the Participants list, enter F6.
Accessing the Meeting Controls Panel During Sharing
Frequently Asked Questions

- Application and Document Sharing, page 83
- Hosting, Joining, and Setting up Meetings, page 84
- Joining a WebEx Meeting or Playing Back a Meeting Recording on Chrome and Firefox, page 86
- Cisco WebEx for Mobile Devices, page 86
- Cisco WebEx for Mobile Devices, page 91
- Downloading Cisco WebEx Applications, page 92
- How Do I Enable Java?, page 94
- How Do I Enable JavaScript?, page 97
- Windows OS: End-User System Requirements, page 98
- Mac OS: End-User System Requirements, page 101
- Optimizing Performance, page 102

Application and Document Sharing

Q. What's the difference between "document sharing" and "application sharing"?

A. With document sharing, attendees can see the document, but you can't change it. With application sharing, you are sharing the application that you used to create the document so as you change the document, your attendees see your changes. Application sharing uses more bandwidth and therefore can affect the overall performance of your meeting.

You can share virtually any type of document or application, but those that stream video or audio may not display properly. To share streaming content, select **Share > Web Browser** and follow the instructions to display the content in a web browser on each attendee's computer. You can share many documents or presentations at the same time; each document or presentation appears on its own tab in the content viewer.

Document sharing requires relatively little bandwidth and thus works well at slower connection speeds. Application sharing requires more bandwidth.
Q. Can I save presentations or documents that contain annotations and view them offline?
A. Yes. Just save the document or presentation to your desktop and then double-click it. The document or presentation displays in the WebEx Document Viewer.

Q. Can I show animations and slide transitions in Microsoft PowerPoint presentations?
A. Yes.

Q. Why do attendees sometimes see a yellow crosshatched pattern when I share applications with them?
A. The crosshatched pattern is the shadow of a window that is displayed on top of the shared application. Just close the window and the pattern disappears.

Q. Can I log chat to an external server?
A. No.

Q. Can I display to more than one monitor during a presentation?
A. No. You can only share to one monitor at a time.

Q. Can I use the camera on my Cisco Unified IP Phone 9971 to present video in a meeting?
A. No. Many audio endpoints support audio and video connectivity. However, only audio connectivity to the Cisco WebEx Meetings Server is supported.

---

Hosting, Joining, and Setting up Meetings

Q. What do I need to host or attend meetings?
A. You must have the Cisco WebEx Meetings application. The first time you start or join a meeting, it is automatically downloaded to your computer. You can also download the application at any time by selecting Downloads from your WebEx site.

Note: Chrome 32 and later and Firefox 27 and later do not support Java. You will be prompted to install the appropriate Cisco WebEx plug-in the first time you attempt to start or join a meeting, or playback a meeting recording.

Q. Can I schedule meetings from Microsoft Outlook?
A. Yes. You can use Outlook to schedule meetings, invite attendees, and start WebEx meetings. The attendees you invite can join your meeting from their Outlook Calendars.

To get started, download and install Cisco WebEx Productivity Tools from your WebEx Downloads page.

---

12 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
For detailed instructions, see the "Scheduling WebEx Meetings with Microsoft Outlook" topic in the Cisco WebEx Meetings Server User Guide.

Note: You must have administrative privileges to install Productivity Tools on Windows computers.

Q. Does a meeting automatically end if it exceeds the scheduled duration?
A. Regardless of the scheduled duration, a meeting can continue up to 24 hours (1440 minutes) as long as there is a host and a participant in the meeting. If a meeting includes only the host (or designated alternate host), it will end after 15 minutes or when the host leaves the meeting. When there is only one person in the meeting, a warning message appears every 15 minutes, "You are the only participant in this meeting. The meeting will automatically end in:". The clock decrements from 2 to 0 minutes. The user can select Continue to extend the meeting. Unlike other types of Cisco WebEx meetings that automatically end after 24 hours, a Blast Dial meeting continues until the last person ends his or her call or leaves the online portion of the meeting. If there is no active speaker in a Personal Conference Number (PCN) meeting, the meeting ends automatically in 2 hours.

Q. Is it possible to restrict features?
A. Yes. If you are a System Administrator, you can enable and disable features, such as Chat, File Transfer, and Sharing, by selecting Settings > Meetings from your Cisco WebEx Administration site.

Q. Why does a user appear twice in the meeting Participant list?
A. It is possible that the user joined the meeting from two different devices, for example, their iPhone and a desktop computer. They might also have inadvertently joined the same meeting twice by opening Meeting Center twice on their desktop. Ask the user to end any additional sessions so that their name displays only once in the meeting.

Q. How many simultaneous meetings can I start as the host?
A. You can start two simultaneous meetings as the host. However, only one license is used.

Q. I would like to host a Blast Dial meeting. How do I do that?
A. Select My Account > Blast Dial information. Fill out the Templates as per your meeting schedule requirements and contact your administrator.

Q. How do I know the PIN for a given blast dial meeting?
A. The host and participant PINs are sent out to hosts and participants respectively via email at the time a Blast Dial group is created. Also, information specific to Blast Dial groups you have been invited to is always accessible by selecting My Account > Blast Dial information.

Q. How do I join the web meeting for a Blast Dial meeting?
A. At the time a Blast Dial meeting is launched, all hosts and participants receive an email with the link to join the meeting as well as any associated PINs & passwords.
Joining a WebEx Meeting or Playing Back a Meeting Recording on Chrome and Firefox

Because of Google and Mozilla policy changes, starting with Chrome 32 and Firefox 27, it might be necessary for users to manually enable the WebEx plug-in when using these browsers to join a WebEx meeting or to play a WebEx recording. More information and instructions can be found at https://support.webex.com/webex/meetings/en_US/chrome-firefox-join-faq.htm.

Cisco WebEx for Mobile Devices

Q. What are the system requirements for using Cisco WebEx Meetings Server 2.0 or higher with my mobile device?
A. Cisco WebEx Meetings Server supports the following:
   - Apple iPhone or iPad: Apple iOS 6.0 and later
   - Android devices: Android 2.1 and later

   Active high-speed Internet connection is required for all mobile devices.

Q. How do I download Cisco WebEx Meetings on my mobile device?
A. Go to your Cisco WebEx site and select Downloads on the top right of the page. Navigate to the WebEx for Mobile Devices section and select Continue. An activation email is sent to you.

   - Apple iPhone or iPad: Make sure to download the app from the Apple Store using the link in your email. Alternatively, you can launch the Apple App Store on your iPhone or iPad and search for "Cisco WebEx Meetings". You'll find this app in the Meet Anywhere category.

   - Android devices: Make sure to download the app from Google Play or the alternative link provided.

Note
Your administrator must configure the system to display the option to download WebEx for mobile devices before you can see it on your WebEx site.

Q. If I can't join a WebEx meeting from my Apple iPhone or iPad running iOS 6.0 or later, and my administrator sends me an email with a certificate file attached, what do I do?

---

13 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
A. If your company uses a self-signed certificate or if your administrator determines that the root certificate installed on your Cisco WebEx Meetings Server is not on Apple’s list of trusted root certificates, you must install a SSL certificate on your mobile device before you join a WebEx meeting.

- From your iOS email account, open the email from your administrator and save the certificate file to your mobile device.
- Tap **Install** on the Install Profile page.
- Tap **Install Now** on the Unsigned Profile dialog.
- Enter your iOS password.
- Tap **Next**.
- Tap **Done**.

**Note**  
Users must have an active high-speed Internet connection for their mobile devices.

Q. How do I activate Cisco WebEx Meetings on my mobile device?  
A. Select the link in your activation email to complete the activation process. If you haven't yet downloaded the WebEx app, the activation link will prompt you to download it from the appropriate site.

- Apple iPhone or iPad: After downloading the app, return to your email and select the activation link again.
- Android devices: Your app will launch automatically after installation. Sign in to finish the activation process.

**Note**  
Your administrator must have enabled the mobile feature for your organization before you can use WebEx on your mobile device.

Q. Why don't I see the download option for WebEx for Mobile Devices?  
A. Your administrator did not configure the Cisco WebEx Meetings Server Administration site to permit the display of this download option.

Q. How do I sign in?  
A. There are several ways to sign in to WebEx depending on how your system is configured. The application will guide you through the sign in process, but here are a few tips:

- If you get an email to activate your WebEx app, select the contained link to activate your service, then enter the email address associated with your WebEx account and your WebEx password to sign in.
- If you're prompted to sign in through your corporate website, enter your WebEx site URL, click **Next**, then enter your user credentials to sign in.
If your WebEx site is configured for single sign-on (SSO), make sure that you enter your corporate user credentials to sign in. If your WebEx site is not configured for SSO, enter your WebEx user credentials.

Tip
- If you have access to multiple WebEx sites, the system will prompt you to choose one after you sign in.
- To join a WebEx meeting you are invited to open the meeting invite in your email inbox or from your Calendar app. Tap on the meeting link in that invite to launch WebEx in your web browser. Optionally, you will be prompted to enter a meeting password. After providing your password, you will be taken to the meeting.

Tip
- If you are not signed in to the WebEx app, the option to join by meeting number is not supported unless you have previously signed in from your mobile device.

Q. How do I start a meeting?
A. As a host, you can easily schedule, start, and invite others to your WebEx meetings from your mobile device.
   - From the My Meetings screen, select the + icon in the upper right corner of the Meeting pane, enter your meeting title, date and time, and then select your desired attendees. If the meeting is starting soon, you can start your meeting from here.
   - If scheduling a meeting for later, tap Schedule and be returned to the My Meetings screen.
   - To start a meeting, select Start.

Note
- You cannot record a WebEx meeting that is scheduled or started with an iPhone or iPad.

Q. How do I join a meeting?
A. Make sure that you have the Cisco WebEx Meetings app installed on your mobile device then join your WebEx meeting using one of the following methods:
   - Go to your WebEx meeting invitation email and click on the link to join the meeting.
   - Sign in to your WebEx account and join from your My Meetings screen.
   - Sign in to your WebEx account and use the Join by Number feature by entering the meeting number.

Q. Why do I see an insecure connection warning when I launch the WebEx application from my Android device?
A. You are trying to access a site with a self-signed certificate. Select Connect to continue launching the application.
Q. How do I join the audio portion of the meeting?
A. When you join a meeting you will be asked whether you would like the system to call your phone or connect you to the audio conference using the Internet. If you select **Connect Using Internet**, the system immediately connects you to the audio conference. Note that the system calls the first number configured on the meeting information screen. If you prefer to use a different number, select **Call Me** to have the system call you at a number of your choosing. You can also manually dial into the audio conference by selecting **Call In** or by calling the call-in number listed on the meeting information screen.

Q. What audio conferencing is supported?
A. Integrated WebEx audio using the Internet or phone. If you do not use integrated WebEx audio, you will need to manually dial into the audio conference or select to have the system call you at a number of your choosing.

Q. Are there any special requirements to join the audio conference using the Internet?
A. If you are using an Android device and want to join the audio through VoIP, make sure that you are using Android SDK 2.3 or above. VoIP on SDK 2.1 and 2.2 is not supported.

To ensure the best audio quality on the iPad, we recommend that you use a headset. Without a headset, the application will mute you by default. To unmute yourself, tap the audio icon and select **Unmute Call**.

---

**Note**
Your administrator must enable the option to connect to the audio conference using the Internet before you can use it. If you are using an iPhone or iPad, you are muted by default when you join an audio conference using VoIP, whether or not you use a headset.

---

Q. Is it free to attend a Cisco WebEx meeting from my mobile device?
A. Yes, there is no cost to download Cisco WebEx Meetings for your mobile device or to attend any WebEx meetings that you've been invited to join. If you are using a mobile data connection, note that you may incur data connection charges though from your mobile provider as per your mobile contract.

Q. Can I invite people to my meeting from my mobile device?
A. Yes, with the app's host capabilities you can invite people to your meeting from the **My Meetings** screen or from the Participant List after joining your meeting.

Q. Can I share video from my mobile device?
A. Yes, if your administrator has configured this feature for your organization, you can use the front-facing camera on your mobile device to send your video to other meeting attendees.

Q. How can I view video on my mobile device?
A. Equipped with multi-channel high quality video, you can view multiple participants' webcam videos simultaneously. Participants sharing video will show up on your screen, followed by silhouettes for participants not sharing video. Scroll back and forth to see all attendees. With voice-activated switching you can automatically see who is speaking. You can also view full-screen video. Just pinch out to enlarge the video. You can go back to the presentation by tapping on the screen. Tap on the button above the speaker video to minimize all video and focus on the presentation.
Q. What is the minimum video resolution on the iPad?
A.  
- Portrait view (3 video screens) - 90p for each video
- Landscape view (4 video screens) - 90p for each video
- Single active speaker - 180p
- Full Screen - 360p

Q. What is the video resolution on Android?
A. Android devices support the following:
- Up to 360p incoming video
- Up to 180p outgoing video

Q. What are the various video capabilities supported in Cisco WebEx Meetings for mobile devices?
A. The following video capabilities are supported:
- You can preview your self-video before sending to other participants.
- Video window view which enables iPhone, iPad and Android tablets to view all video enabled participants (including self) — simply swipe left / right to view all others. For Android smartphones, turn the phone to landscape to see the video strip and be able to swipe left / right.
- "Active-speaker" view in which participants can see who's talking as well as the content being shared simultaneously (simultaneous video and content sharing on iPad only); the "active speaker" picture-in-picture frame can be moved around on iPads and iPhones, not on Android devices.
- Video conferencing view in which participants can see who is talking in fullscreen mode with self-view as picture-in-picture is supported on iPad and iPhone.

Q. How can I chat with other participants?
A. Tap on the people icon on the top of your screen to view the Participant List. From the list, you can choose one individual or all participants to chat with. Select who you want to chat with and then enter your message in the dialogue box and select Send. If video is being shared, you can chat directly from the video carousel. Tap a participant and choose to chat with that individual or with the entire group.

To transition back and forth between the presentation and chat, tap the Cancel button in the chat window and be returned to the presentation.

Q. Can I present content from my mobile device?
A. You can present content from your iPad if you are the host of the meeting. However, a desktop user cannot pass the ball to you if you are a mobile user. Presenting content is not supported on the iPhone or Android devices.

Q. How do I pass presenter control?
A. Tap on the "Pass the Ball" tip to get detailed instructions or click on the Participant List, select the WebEx ball, and drag and drop it to the new presenter. If video is being shared, you can also tap on the participant in the video carousel to pass presenter control.

Note

Passing the presenter role to users on mobile devices is limited to the following:

- If the meeting is started from an Android device: You can transfer the presenter role to users using an iOS 7 iPad
- If the meeting is started from an iPhone: You can transfer the presenter role to users using an iOS 7 iPhone
- If the meeting is started from a desktop computer: You cannot transfer the presenter role to users on mobile devices

Cisco WebEx for Mobile Devices

Q. Why don't I see the download option for WebEx for Mobile Devices?
A. Your administrator did not configure the Cisco WebEx Meetings Server Administration site to permit the display of this download option.

Q. Why do I see an insecure connection warning when I launch the WebEx application from my Android device?
A. You are trying to access a site with a self-signed certificate. Ensure the application is genuine and select Connect to continue launching the application.

Q. What audio conferencing is supported?
A. Integrated WebEx audio using the Internet or phone. If you do not use integrated WebEx audio, you will need to manually dial into the audio conference or select to have the system call you at a number of your choosing.

Q. Are there any special requirements to join the audio conference using the Internet?
A. If you are using an Android device and want to join the audio through VoIP, make sure that you are using Android SDK 2.3 or above. VoIP on SDK 2.1 and 2.2 is not supported.

To ensure the best audio quality on the iPad, we recommend that you use a headset. Without a headset, the application will mute you by default. To unmute yourself, tap the audio icon and select Unmute Call.

Note

Your administrator must enable the option to connect to the audio conference using the Internet before you can use it. If you are using an iPhone or iPad, you are muted by default when you join an audio conference using VoIP, whether or not you use a headset.
Q. Is it free to attend a Cisco WebEx meeting from my mobile device?
A. Yes, there is no cost to download Cisco WebEx Meetings for your mobile device or to attend any WebEx meetings that you’ve been invited to join. If you are using a mobile data connection, note that you may incur data connection charges though from your mobile provider as per your mobile contract.

Q. What is the video resolution on the iPad?
A. • Portrait view (3 video screens) - 90p for each video
   • Landscape view (4 video screens) - 90p for each video
   • Single active speaker - 180p
   • Full Screen - 360p

Q. What is the video resolution on Android?
A. Android devices support the following:
   • Up to 360p incoming video
   • Up to 180p outgoing video

Q. What are the various video capabilities supported in Cisco WebEx Meetings for mobile devices?
A. The following video capabilities are supported:
   • You can preview your self-video before sending to other participants.
   • Video window view which enables iPhone, iPad and Android tablets to view all video enabled participants (including self) — simply swipe left / right to view all others. For Android smartphones, turn the phone to landscape to see the video strip and be able to swipe left / right.
   • "Active-speaker" view in which participants can see who's talking as well as the content being shared simultaneously (simultaneous video and content sharing on iPad only); the "active speaker" picture-in-picture frame can be moved around on iPads and iPhones, not on Android devices.
   • Video conferencing view in which participants can see who is talking in fullscreen mode with self-view as picture-in-picture is supported on iPad and iPhone.

---

**Downloading Cisco WebEx Applications**

Q. Why don’t I see the Productivity Tools and WebEx Meetings application on the Downloads page?
A. Your administrator has selected the Manually push WebEx desktop applications to user’s desktop option and prefers to manually push the required WebEx applications to your desktop.
Q. How can I check to see if the administrator has pushed the WebEx Productivity Tools and WebEx Meetings application to my desktop?
A. You will find the WebEx Productivity Tools by selecting Start > All Programs > WebEx > Productivity Tools > WebEx Assistant. The WebEx Meetings application will be in your Control Panel (Control Panel > Programs > Programs and Features > Cisco WebEx Meetings).

Q. What happens if I don't see the WebEx Meetings application in the Control Panel and I've been invited to a Cisco WebEx meeting?
A. Select the join meeting link in the email invitation and follow any displayed instructions.

Q. I see only the WebEx for iPhone and iPad option on the Downloads page. Why don't I see the other WebEx applications?
A. Your administrator prefers to silently push the required WebEx applications to your desktop but is providing access to the WebEx for iPhone and iPad app.

Q. I only see the WebEx for Mobile Devices option on the Downloads page. Why don't I see the other WebEx applications?
A. Your administrator prefers to silently push the required WebEx applications to your desktop but is providing access to the app for mobile devices.

Q. As an administrator, how do I configure the system to allow users to download WebEx Productivity Tools and the WebEx Meetings application?
A. You need to select the appropriate Downloads option.
   1. Sign in to the Cisco WebEx Meetings Server Administration site.
   2. Select Settings > Downloads.
   3. Select Permit users to download WebEx desktop applications.
   4. Select Save.

Q. As an administrator, can I determine which WebEx applications to silently push to users?
A. Yes, you need to select the appropriate Downloads option.
   1. Sign in to the Cisco WebEx Meetings Server Administration site.
   2. Select Settings > Downloads.
   3. Select Manually push WebEx desktop applications to user's desktop.
   4. Select Save.
   5. Select Download for each application you want to make available to users.
      When you select Download, a Windows installer ZIP file is saved to your hard drive. You can push the .msi file to your users with Windows systems.
      • WebEx Meetings application - required for users to participate in meetings.
• Productivity Tools - lets users schedule, start, and join meetings without accessing the WebEx site, and includes the WebEx Integration to Microsoft Outlook.

• WebEx Network Recording Player - lets users download meeting recordings to convert or play them offline.

Q. As an administrator, how do I configure the system to display the download option for Cisco WebEx Meetings for iPhone and iPad?

A. You need to select the appropriate Downloads option.

1. Sign in to the Cisco WebEx Meetings Server Administration site.

2. Select Settings > Mobile.

3. Check the iOS WebEx application check box.

4. Select Save.

Q. As an administrator, how do I configure the system to display the download option for WebEx for Mobile Devices?

A. You need to select the appropriate Downloads option.

1. Sign in to the Cisco WebEx Meetings Server Administration site.

2. Select Settings > Mobile.

3. Select the checkboxes for the mobile devices you want to enable.

4. Select Save.

How Do I Enable Java?

• Enabling Java in the Control Panel

• Enabling Java in Your Browser (Windows)

• Enabling Java in Your Browser (Mac)

Enabling Java in the Control Panel

To ensure the best possible meeting experience, download and install the latest releases of Java software for your supported web browser. For further assistance, contact your systems administrator.
Chrome 32 and later and Firefox 27 and later do not support Java. The following information applies if you are using a browser other than the ones mentioned.

1. Go to the Java icon to open the Java Control Panel.
2. Select the Advanced tab.
3. Expand Default Java for browsers.
4. Check the box next to one or more browser names.
5. Select Apply.

### Enabling Java in Your Browser (Windows)

**Note** Instructions may vary per browser version.

**Internet Explorer**

1. Select Tools > Internet Options.
2. Select the Security tab, then select Custom level.
3. Make sure that Scripting of Java applets is enabled.
4. Select OK to save your changes.

**Firefox**

1. Start Mozilla Firefox browser or restart it if it is already running.
2. Select Tools > Add-ons.
3. Select Plugins.
5. Select Enable.

**Note** If you see the Disable button, the plugin is already enabled.

**Chrome**

1. Click on the customize icon, then select Settings.
2. Select Show advanced settings.
3. Scroll down to the Privacy section, then select Content settings.

---

14 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
4 Scroll down to the Plug-ins section, then select **Disable individual plug-ins** to check whether Java is already enabled.

5 If Java is not already enabled, select **Enable**.

**Note**
If you see the Disable link, the plugin is already enabled.

---

**Enabling Java in Your Browser (Mac)**

**Note**
Instructions may vary per browser version.

**Safari**
1 Select **Safari > Preferences**.
2 Select the **Security** tab and make sure that **Allow Java** is checked.

**Firefox**
1 Select **Tools > Add-ons**.
2 From the Add-ons Manager, select **Plugins**.
3 Select **Enable** for Java Applet Plug-in.

**Note**
If you see the Disable button, the plugin is already enabled.

**Chrome**
1 Click on the customize icon, then select **Settings**.
2 Select **Show advanced settings**.
3 Scroll down to the Privacy section, then select **Content settings**.
4 Scroll down to the Plug-ins section, then select **Disable individual plug-ins** to check whether Java is already enabled.
5 If Java is not already enabled, select **Enable**.

**Note**
If you see the Disable link, the plugin is already enabled.
How Do I Enable JavaScript?

Windows

Instructions may vary per operating system and browser version.

Internet Explorer
1 Select Tools > Internet Options.
2 Select the Security tab.
3 Select Custom level.
4 Make sure Active scripting is enabled.

Firefox
1 Select Tools > Options.
2 Select the Content tab and make sure that Enable JavaScript is checked.

Chrome
1 Select the customize icon then select Settings.
2 Select Show advanced settings.
3 Scroll down to the Privacy section and select Content settings.
4 Select Allow all sites to run JavaScript or select Manage exceptions to allow your WebEx site.
5 When finished, select Done.

Mac

Instructions may vary per operating system and browser version.

Safari
1 Select Safari > Preferences.
2 Select the Security tab and make sure that Enable JavaScript is checked.

Firefox
1 Select Firefox > Preferences.
2 Select the Content tab and make sure that Enable JavaScript is checked.

Chrome
1 Select the customize icon then select Settings.
2. Select **Show advanced settings**.

3. Scroll down to the Privacy section and select **Content settings**.

4. Select **Allow all sites to run JavaScript** or select **Manage exceptions** to allow your WebEx site.

5. When finished, select **Done**.

**Windows OS: End-User System Requirements**

- Supported Windows Operating Systems
- Windows Hardware Requirements
- Supported Windows Browsers
- Microsoft Outlook Integration
- Supported Instant Messenger Clients
- Cisco Jabber for Windows Integration

**Q.** What are the end-user system requirements for Windows operating systems?

**A.** See the following sections:

**Supported Windows Operating Systems**

- Windows XP SP3
- Windows Vista (32-bit/64-bit)
- Windows 7 (32-bit/64-bit)
- Windows 2008 Server (64-bit)
- Windows 8 (32-bit/64-bit)
- Windows 8.1 (32-bit/64-bit)
- Windows 10 (32-bit/64-bit) (CWMS 2.6MR1 and higher)
- Edge (Windows 10 only) 20.10240.16384.0 to 38.14393.00

**Note**

Support for Microsoft Windows 10 Redstone 1, also known as Windows 10 Anniversary Update (Version 1607), was added in CWMS version 2.7.

**Windows Hardware Requirements**

Intel Core2 Duo or AMD CPU 2.XX GHz or higher processor.
A minimum of 2 GB of RAM is recommended.

**Supported Windows Browsers**

- Internet Explorer: 8 - 11.103.14393.0
  - IE 11 tested on Windows 7 SP1 and Windows 8.1
- Internet Explorer: 8 - 10
- Mozilla Firefox: 10—50
  - Mozilla Firefox: 34 - 37 tested in version 2.5MR4
  - See the Firefox release schedule at [https://wiki.mozilla.org/RapidRelease/Calendar](https://wiki.mozilla.org/RapidRelease/Calendar)
- Google Chrome: 23 - 37
- Google Chrome: 23 - 54.0.2840.99
  - Google Chrome: 39 - 42 tested in version 2.5MR4
  - See the Chrome release schedule at [http://www.chromium.org/developers/calendar](http://www.chromium.org/developers/calendar)

**Microsoft Outlook Integration**

- Microsoft Outlook 2007 SP2 and later
- Microsoft Outlook 2010 (32-bit and 64-bit editions; all service packs)
- Microsoft Outlook 2013
- Microsoft Outlook 2016 (CWMS 2.6MR1)

The following table describes which versions of Microsoft Outlook are supported on what operating systems.

<table>
<thead>
<tr>
<th>Microsoft Outlook Version (Client/Exchange server)</th>
<th>Vista</th>
<th>Windows 7</th>
<th>Windows 8 (Desktop Mode Only)</th>
<th>Windows 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlook 2007/Exchange 2007</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Outlook 2010/Exchange 2007</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Outlook 2010/Exchange 2010</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Outlook 2013/Exchange 2010</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Outlook 2010/Exchange 365 Hosted</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Microsoft Outlook Version (Client/Exchange server)</td>
<td>Vista</td>
<td>Windows 7</td>
<td>Windows 8 (Desktop Mode Only)</td>
<td>Windows 10</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------</td>
<td>-----------</td>
<td>-------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Outlook 2013/Exchange 2013</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Outlook 2013/Exchange 365 Hosted</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Outlook 2016/Exchange 365 Hosted</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Outlook 2010/Exchange 2016</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y - supports window 7,8,10</td>
</tr>
<tr>
<td>Outlook 2013/Exchange 2016</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y - supports window 7,8,10</td>
</tr>
<tr>
<td>Outlook 2016/Exchange 2016</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y - supports window 7,8,10</td>
</tr>
<tr>
<td>Outlook 2016/Exchange 2010</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y - supports window 7,8,10</td>
</tr>
<tr>
<td>Outlook 2016/Exchange 2013</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y - supports window 7,8,10</td>
</tr>
</tbody>
</table>

**Supported Instant Messenger Clients**

<table>
<thead>
<tr>
<th>Instant Messenger Version</th>
<th>Windows XP SP3</th>
<th>Windows 7</th>
<th>Windows 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communicator 2007</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Communicator 2007 R2</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Lync 2010 (32-bit)</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Lync 2013 (32-bit)</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

**Cisco Jabber for Windows Integration**

- Cisco Jabber for Windows 9.2.6
- Cisco Jabber for Windows 9.6.1
• Cisco Jabber for Windows 9.7
• Cisco Jabber for Windows 10.5
• Cisco Jabber for Windows 11.0
• Cisco Jabber for Windows 11.5 (CWMS 2.6MR1)
• Cisco Jabber for Windows 11.6
• Supports Cisco WebEx Meetings Server with LDAP/Active Directory integration.

Restriction
Jabber for Windows 9.2.6 supports integration with Cisco WebEx Meetings Server 1.5 and later sites that are configured for SAML 2.0 single sign-on (SSO). Earlier versions of Jabber for Windows do not support single sign-on.

Not all Cisco Jabber versions or platforms support integration with Cisco WebEx Meetings Server. (For example, cloud-based Jabber and WebEx Communicator.) For information about integrating with Cisco WebEx Meetings Server, see the Cisco Jabber for Windows documentation at http://www.cisco.com/en/US/products/ps12511/tsd_products_support_series_home.html.

Mac OS: End-User System Requirements

• Supported Mac Operating Systems

• Supported Mac Browsers

Q. What are the end-user system requirements for Mac operating systems?
A. See the following sections:

Supported Mac Operating Systems
• Mac OS X 10.7 Lion
• Mac OS X 10.8 Mountain Lion
• Mac OS X 10.9 Mavericks
• OS X 10.11 El Capitan (CWMS 2.6MR1)
• OS X 10.12 Sierra (CWMS 2.7MR2)

Supported Mac Browsers
• Apple Safari: 6—9.1.3
• Apple Safari: versions supported by the supported operating systems (Mac OS X 10.6, 10.7, 10.8)
• Google Chrome: 23—53.0.2743.116

See the Chrome release schedule at http://www.chromium.org/developers/calendar
Google Chrome: 39 - 42 in version 2.5MR4
- Goggle Chrome: 23 - latest
- Mozilla Firefox: 10—48.1
- Mozilla Firefox: 10 - 25
- Mozilla Firefox: 10 - latest

See the Firefox release schedule at https://wiki.mozilla.org/RapidRelease/Calendar.

**Optimizing Performance**

**Q.** What can I do to get the best performance?

**A.** Some factors that affect performance include:

- The speed of your Internet connection
- Internet traffic between you and the Cisco WebEx Meetings Server
- The performance of any firewall and proxy servers on your network

To improve performance:

- Get the fastest internet connection possible
- Use document (presentation) sharing instead of application or desktop sharing
- Share documents that contain fewer images
Troubleshooting

- Participants List Displays Multiple Entries for the Same User, page 104
- Internet Explorer Browser Not Supported, page 104
- 404 Page Not Found Error Encountered, page 104
- Cannot Start or Join Meeting, page 105
- SSO Does Not Work with iOS Devices, page 106
- Meeting Details Page Displays Incorrect Information, page 107
- Meeting Client Does Not Load, page 107
- Adobe Reader Launches Automatically, page 108
- Incorrect Version of Productivity Tools Displayed in the Control Panel, page 109
- Error Message: Setup was Unsuccessful, page 109
- Error Message: Host Access Code and Host PIN Combination is Incorrect, page 110
- Error Message: Participant Access Code is Incorrect, page 110
- Error Message: We've Hit a Glitch Processing Your Request, page 110
- Error Message When Regenerating Access Codes, page 111
- Error When Deleting a Personal Conference Account, page 111
- Invitees Do Not Receive Reminder Email Messages, page 111
- Cannot Join a Personal Conference Meeting, page 111
- Cannot Install WebEx Productivity Tools, page 111
- "Remember Me" Function Does Not Work, page 112
- Cannot Record Meeting, page 112
- Cannot Play a Meeting Recording, page 112
- Experiencing Audio or Video Issues During Meetings, page 113
- Deleting Meetings Scheduled By a Deactivated User, page 114
- Web Presentation Pauses, page 114
Participants List Displays Multiple Entries for the Same User

**Possible Cause** This may occur because the same user signed in to the meeting from multiple devices. For example, a user joins a meeting from home before heading into the office. The same user then joins the meeting using his iPhone while he is in the car then joins the meeting again from his computer when he arrives at the office. If the user forgot to end his previous session before joining through a new device, he will be displayed in the meeting three times.

**Solution** Participants should end each session before joining through different devices. Maintaining duplicate sessions for the same user will impact the available capacity of your WebEx system.

Internet Explorer Browser Not Supported

**Problem** You are using Microsoft Internet Explorer 8, which is supposed to be supported. However, you see an error message stating that the browser version is not supported.

**Possible Cause** The browser is in Compatibility View mode, which effectively uses Internet Explorer 7 logic.

**Solution** Turn off compatibility view mode.

1. Open an Internet Explorer browser window.
2. Select **Tools > Compatibility View Settings**.
3. Verify the following:
   - The WebEx site is not listed in the list of websites you've added to compatibility view.
   - **Display intranet sites in Compatibility View** is unchecked.
   - **Display all websites in Compatibility View** is unchecked.
4. Select **Close**.

404 Page Not Found Error Encountered

**Problem** You see a "404 page not found" error or you encounter connection problems when signing in or joining meetings from your device running Microsoft Windows.

**Solution** Use the following checklist to make sure your device is properly set up to send and receive data:

- Check your network connection.
- Try using a different computer.
Use a supported browser. Ensure that the version of Internet Explorer on your computer is 8 or later, even if you don't intend to use IE for Cisco WebEx Meetings.

Turn on TLS 1.0, TLS 1.2, and SSL 3.0 by accessing the Control Panel > Internet Options. Select the Advanced tab. A list of checkboxes displays. Scroll the list to locate the Security group. Under Security, make sure that the TLS 1.0, TLS 1.2, and SSL 3.0 checkboxes are checked.

**Cannot Start or Join Meeting**

**Possible Cause** You are using Firefox 27 or later or Chrome 32 or later and require the Cisco WebEx Meetings plug-in.

**Solution** If you see a prompt to install a Cisco WebEx plug-in, select Download and follow the instructions to install the required plug-in.

**Note** After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the Always allow plug-ins... option and select Done.
- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select Allow and Remember.

If the meeting does not start automatically, refresh the page.

If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you might be required to complete the following one-time installation to add the Cisco WebEx extension to your Chrome browser:

1. Select Add WebEx to Chrome.
2. Select Free on the Cisco WebEx Extension dialog.
3. Select Add to add the Cisco WebEx extension to your Chrome browser.
4. Open the Cisco_WebEx_Add-on.exe file and select Run.
5. The page refreshes when the installation has finished. If the meeting does not start automatically, refresh the page.

**Possible Cause** If you are using a browser other than Firefox or Chrome, you might not have Java installed on your computer.

**Solution** Go to http://www.java.com to install Java 1.6.034 or above or Java 1.7.06 or above.

**Possible Cause**

- You do not have Internet Explorer (IE) 8 or 9 installed on your computer. The latest version of Internet Explorer installed on your computer must be 8 or above, whether or not you intend to use IE to join a WebEx meeting.
- Your systems administrator has turned on an encryption mode, and your browser is not set up to process the encrypted data.
**Solution** Set up your browser appropriately. Go to Control Panel > Internet Options, select the Advanced tab, and then ensure that TLS 1.0, TLS 1.2, and SSL 3.0 are checked. For details, see 404 Page Not Found Error Encountered, on page 104.

**Possible Cause** You are using Internet Explorer with Google Chrome Frame.

**Solution** Internet Explorer with Google Chrome Frame is not supported. Use a different browser that has been tested to work with this release of Cisco WebEx Meetings Server. You can find the list of tested browsers in the Cisco WebEx Meetings Server FAQs here: http://www.cisco.com/en/US/products/ps12732/products_user_guide_list.html.

**Possible Cause** If you see the message, "Java is not working" while trying to join a WebEx meeting, your Java SE Runtime Environment (JRE) needs to be updated to Java SE 7 Update 51 or later.

**Solution** On the displayed message dialog, select Click here to determine if Java is installed on your computer. If Java is installed, close the browser and try to join a WebEx meeting again. If Java is not installed on your computer or if the "Java is not working" message displays again, complete the following steps to download the latest version:

2. Select the download link that is appropriate for your computer.
3. Close your browser.
4. Open a new browser and join a WebEx meeting.

**Possible Cause** If a security warning message displays when you attempt to join a WebEx meeting, add the WebEx site URL to the exception site list on the Java Security page.

**Solution** To add the WebEx site URL to the exception site list on the Java Security page:

1. Select Start > Control Panel > Java
3. Select Edit Site List.
4. In the Exception Site List section, enter the WebEx site URL and select OK.
5. Close your browser.
6. Open a new browser and join a WebEx meeting.

---

**SSO Does Not Work with iOS Devices**

**Problem** Single Sign-On is not working with your iOS device.

**Possible Cause** There is a known issue with Apple iOS 6.x, where Single Sign-On (SSO) does not work for internal users of iPad/iPhone who are using the Safari 6 web browser. This is due to an Apple defect that is fixed in iOS 7. The Safari bug ID is 13484525.

**Solution** Use a different web browser. See the "Operating System and Browser Requirements" section of the Cisco WebEx Meetings Server Planning Guide and System Requirements for a list of supported browsers on the Mac operating system.
Meeting Details Page Displays Incorrect Information

**Problem** When I click the **Join** button to join a meeting, the meeting details page displays the wrong date.

**Possible Cause** There is a known issue whereby the system skips recurring meeting instances that were not attended. For example:

- A user schedules a recurring series of meetings that take place every Wednesday: July 1, July 8, July 15, July 22.
- When you click the link to join your meeting on July 1st, the meeting details page reflects that you are joining the meeting scheduled for July 1st.
- No one joins the meeting on July 8th.
- When you click the link to join your meeting on July 15th, the meeting details page incorrectly reflects that you are joining the meeting scheduled for July 8th. You can still attend this meeting.
- When you click the link to join your meeting on July 22nd, the meeting details page correctly reflects that you are joining the meeting scheduled for July 22nd since the previous instance of the recurring meeting series was attended.

**Solution** This is a known issue in this release of Cisco WebEx Meetings Server. Join your meeting as you normally would regardless of the date displayed on the meeting details page.

Meeting Client Does Not Load

**Problem** I can't join a meeting because the meeting client does not load.

**Possible Cause** You are using Firefox or Chrome and require the Cisco WebEx Meetings plug-in.

**Solution** If you see a prompt to install a Cisco WebEx plug-in, select **Download** and follow the instructions to install the required plug-in.

---

**Note** After installing the plug-in, it might be necessary to enable it.

- If you are using Chrome, select the plug-in icon that displays on the top right of your page, check the **Always allow plug-ins...** option and select **Done**.
- If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before https:) and select **Allow and Remember**.

If the meeting does not start automatically, refresh the page.

---

**Possible Cause** This may be because you are using a private CA or self-signed server certificate.

**Solution** Load the corresponding root certificate on your machine prior to joining a meeting.

Complete the following steps if you are using a Mac:

1. Open your Keychain Access application by selecting **Applications > Utilities > Keychain Access**.
2. In the left column, under Keychains, make sure that **login** is selected.
3 In the right column, double-click the untrusted certificate so that you can modify its information.

Note
The certificate will have an x icon next to it.

4 From the certificate window, do the following:

   1 Expand the Trust section so that you can see the parameters in this section.
   2 For When using this certificate, select Always Trust.
   3 Enter your system account and password information.
   4 Select Save Changes.

       The icon next to the certificate will change from an x to a +.

Complete the following steps if you are using Internet Explorer on Windows:

1 Open the Cisco WebEx Meetings Server site in your Internet Explorer browser.
2 Select Continue to this website (not recommended).
3 Select the Certificate Error button next to the browser address bar.
4 Select View certificates.
5 In the Certificate window, select Install Certificate, then complete the following steps in the Certificate Import Wizard:
   a On the Welcome page, click Next.
   b Select Place all certificates in the following store, then click Browse.
   c In Select Certificate Store, select Trusted Root Certification Authorities, then click OK.
   d Select Next, then select Finish to import the certificate.
   e In the Security Warning window, select Yes to install the certificate.
   f Select OK to complete the wizard.
6 Select OK to close the Certificate window.
7 Restart Internet Explorer and reopen the Cisco WebEx Meetings Server site.

Adobe Reader Launches Automatically

Problem Adobe Reader launches automatically on the host's local computer when a PDF file is shared.

Solution This is expected behavior. Manually quit Adobe Reader and proceed to share your document.
Incorrect Version of Productivity Tools Displayed in the Control Panel

**Problem** The version of Cisco WebEx Productivity Tools displayed in the About WebEx Productivity Tools in the WebEx Assistant shows a newer version than the version displayed in the Programs and Features in the Microsoft Windows Control Panel.

**Possible Cause** The administrator selected the option on the Administration site to automatically update WebEx Productivity Tools when a new version is available.

**Solution** When an administrator selects the option to automatically update WebEx Productivity Tools, the system prompts users to install an update when a new version of WebEx Productivity Tools is available. After the installation is complete, the version of Cisco WebEx Productivity Tools displayed in the Programs and Features in the Windows Control Panel shows the older version number. This is a known issue and will be fixed in a later release.

Error Message: Setup was Unsuccessful

**Problem** User attempts to join a meeting from Internet Explorer and receives the error message "Setup was unsuccessful. Please try again."

**Possible Cause** There may be an issue with your version of Cisco WebEx Meetings.

**Solution** Complete the following workaround:

1. Uninstall the Cisco WebEx Meetings application.
   In Windows 7, this is done by navigating to Start > All Programs > Control Panel > Programs and Features. This path may differ depending on your operating system.

2. Delete the "C:\Program Files\WebEx\" folder if it exists.
3. Open a web browser and navigate to your WebEx site.
4. Select the Downloads link in the upper right corner of the page and re-install the Cisco WebEx Meetings application.
5. Try to start or join a meeting again.

If the issue recurs, send the log file and "C:\Program Files\WebEx\ieatgpc.dll" file to your Cisco WebEx support representative.
Error Message: Host Access Code and Host PIN Combination is Incorrect

**Problem** When I dial in to a Personal Conference meeting or connect to the online portion of the Personal Conference meeting because I'm using a computer with a headset, I receive an error message indicating that the host access code and host PIN combination is incorrect.

**Solution** Check your host PIN and host access code, and verify that you can sign in to your WebEx site:

- Go to your My Account page and select **Personal Conferencing** in the My Audio Connection Options section. Verify that you are using the correct host PIN and host access code generated for the Personal Conference account you used when you scheduled the meeting. If you regenerated access codes for an account after you scheduled the meeting, the old host access code will not work.

- Check to make sure that you can sign in to your WebEx site. Your user account may have been inadvertently deactivated. If you can sign in to your WebEx site and you are using the correct host access code and host PIN, you may want to delete the current meeting and schedule a new Personal Conference meeting.

Error Message: Participant Access Code is Incorrect

**Problem** As an invitee, when I dial in to a Personal Conference meeting or connect to the online portion of the Personal Conference meeting because I'm using a computer with a headset, I receive an error message indicating that the participant access code I entered is incorrect.

**Solution** Go to your meeting email invitation and verify that you are entering the correct participant access code. If you are entering the participant access code displayed in the email invitation, contact the meeting host to make sure the code has not changed since the host scheduled the meeting. If the host regenerated access codes after scheduling the meeting, the host may have to cancel the current meeting and schedule a new Personal Conference meeting.

Error Message: We've Hit a Glitch Processing Your Request

**Problem** When I attempt to add or delete a Personal Conference account or regenerate Personal Conference access codes, I receive the error, "We've hit a glitch processing your request. Try again a little later."

**Possible Cause** There may be a network issue or the back-end connection failed.

**Solution** Wait a few minutes and try to add or delete an account or regenerate access codes again. If you see the same error, contact your administrator for assistance.
**Error Message When Regenerating Access Codes**

**Problem** I'm trying to regenerate access codes for a Personal Conference account but I receive an error message.

**Solution** If you are hosting a Personal Conference meeting and the meeting is in progress, wait until the meeting has ended and try again. If you do not have a Personal Conference meeting in progress, and the system does not regenerate the access codes for an account, there may be a network issue. Contact your administrator for assistance.

**Error When Deleting a Personal Conference Account**

**Problem** I'm trying to delete a Personal Conference account but I receive an error message.

**Solution** If you are hosting a Personal Conference meeting and the meeting is in progress, wait until the meeting has ended and try again. If you do not have a Personal Conference meeting in progress, and the system does not delete an account, there may be a network issue. Contact your administrator for assistance.

**Invitees Do Not Receive Reminder Email Messages**

**Problem** As a meeting host, when I press *7 on the phone keypad, invitees do not receive reminder email messages for my Personal Conference meeting.

**Solution** The *7 function works only when you schedule a Personal Conference meeting and include invitees in the Who field on the Schedule a WebEx Meeting page. If you did not schedule the Personal Conference meeting using your WebEx site or the WebEx Assistant, the *7 function will not send email reminders to invitees.

**Cannot Join a Personal Conference Meeting**

**Problem** When I dial in to a Personal Conference meeting and enter the meeting number, I'm not connected to the meeting.

**Possible Cause** Although the phone prompts you to enter a Participant Access code or a meeting number, you should enter only the Participant Access code to access a Personal Conference meeting. The meeting number is used for WebEx Audio calls.

**Solution** Hang up your phone and try to dial in to the Personal Conference meeting again, but enter the Participant Access code.

**Cannot Install WebEx Productivity Tools**

**Possible Cause** Your computer may lack administrative privileges to perform the installation.
"Remember Me" Function Does Not Work

**Problem** I selected Remember Me on the sign-in page, but I still had to reenter my information when signing in the next time.

**Possible Cause** Cookies in your browser might be turned off.

**Solution** First, ensure that you are using a supported browser. You can find them listed in the FAQs at [http://www.cisco.com/en/US/products/ps12732/products_user_guide_list.html](http://www.cisco.com/en/US/products/ps12732/products_user_guide_list.html). Then turn on cookies in your browser. For help in doing so, contact your system administrator.

Cannot Record Meeting

**Problem** The Record button is grayed out so I cannot record my WebEx meeting.

**Possible Cause**
- You scheduled the WebEx meeting using an Apple iPhone or iPad.
- The WebEx meeting was started by a person using an Apple iPhone or iPad.

**Solution**
- Continue with your meeting even though it is not being recorded. Video, audio and desktop sharing features will operate properly.
- Ask all participants to leave the WebEx meeting, then cancel the meeting and use your computer to schedule a replacement meeting. Start the new meeting from your computer, then select the Record button to begin recording your meeting.

**Note** If you use your computer to schedule and start a WebEx meeting, you can record the meeting even if invitees join the meeting using a mobile device.

Cannot Play a Meeting Recording

**Problem** When I receive an email message with a link to a WebEx meeting recording, I select the link to play the recording but receive an error message.

**Possible Cause** The administrator has selected a configuration setting that requires users to be signed in to a WebEx site to play a meeting recording.

**Solution** Sign in to a WebEx site. Then select the link to the recording in the WebEx meeting recording email you received.
Experiencing Audio or Video Issues During Meetings

**Problem** You hear constant background noise or buzzing sounds.

**Possible Cause** Your device may be experiencing a network bandwidth issue.

**Solution** If you are on 3G, try switching to Wi-Fi if it is available.

**Problem** You cannot hear the speaker.

**Possible Cause** The microphone or speaker setting on your headset may not be properly adjusted.

**Solution** If you are using a headset, see Fine-Tuning Your Microphone and Speaker Settings, on page 19 for more information about adjusting your headset settings.

**Problem** If you are using video, you see a noticeable delay in the audio.

**Possible Cause** Other applications are using a lot of system resources, for example if you are downloading a large file.

**Solution** If you are downloading a large file, you may want to cancel the download job and restart it after the meeting.

**Problem** A speaker hears an echo of what he is saying.

**Possible Cause** If your device has an earpiece, audio may be coming out of the earpiece instead of the speaker.

**Solution** Plug in a headset for better audio quality.

**Problem** The video for other participants cannot load or freezes.

**Possible Cause** Your device may not have adequate memory.

**Solution** If you are using a computer, it needs at least 2 GB of RAM.

**Problem** You cannot send your video.

**Possible Cause** If you cannot send video, another application may be already occupying your device's camera.

**Solution** If you have other applications running in the background, you may want to close them.

**Problem** You cannot hear audio through your Bluetooth headset.

**Possible Cause** Not all Bluetooth headsets are supported, depending on the platform of your mobile device.

**Solution** Contact your administrator for help.
Deleting Meetings Scheduled By a Deactivated User

Problem  I have meetings displaying on my calendar that were scheduled by a user who is no longer with the organization.

Possible Cause  When users leave an organization, they are deactivated from the Cisco WebEx system. Since meeting schedulers are the only users who can cancel their own meetings, any meetings they scheduled before they were deactivated remain in the system and cannot be canceled.

Solution  Manually delete the meeting entries from your calendar.

Web Presentation Pauses

Problem  I am using dual monitors to share content during a web conference. When I turn on my webcam video in full-screen mode on one of my screens, my presentation automatically pauses on the other screen and participants are unable to see the changes I make in my presentation.

Possible Cause  Cisco WebEx Meetings does not support video in full-screen mode while you are also presenting content during a web conference.

Solution  Minimize your video to resume your presentation.

Cannot Access Help

Problem  The links for the Help content don't seem to work.

Possible Cause  This may be due to a connection issue.

Solution  Try to open the link from another web browser. If the link still does not open, check whether or not you can visit Internet sites outside your internal network. If your network is restricted to internal sites, contact your administrator to define a customized link for your organization's Cisco WebEx help content.

Display Issues When Sharing on Windows 8 or 10

Problem  When I share my screen on my PC running Microsoft Windows 8 or Windows 10, attendees see gray boxes instead of the WebEx session controls, and chat and participants windows. If you share an application instead of your desktop, unshared applications or popups in the foreground appear as gray boxes to attendees.

Possible Cause  This is a known issue when sharing on a PC running Microsoft Windows 8 or 10.

Solution  Inform your attendees of the issue before you share your screen.
Display Issues When Sharing Using Dual Monitors

**Problem**  When some presenters share an application, attendees see areas of yellow mesh. This occurs if the presenter is using dual monitors and the primary monitor is smaller than the secondary monitor. The larger area of the secondary monitor appears as yellow mesh for attendees.

**Possible Cause**  This is a known issue when sharing using dual monitors.

**Solution**  Do not use dual monitors when sharing an application in a WebEx meeting.